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FEDERAL COMMUNICATIONS COMMISSION NOTICE 
 

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation.  

This equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation.  

If this equipment does cause harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures: 

• Reorient or relocate the receiving antenna.                                                               

• Increase the separation between the equipment and the receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected. 

• Consult the dealer or an experienced radio/TV technician for help. 
 
 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference and (2) this device must 
accept any interference received, including interference that may cause undesired operation. 

 

 

 

 

 

 

 

 
 

 

 

 
 

For environmental reasons, your TheaterTouch universal system controller 
uses “environmentally sound” nickel metal-hydride rechargeable batteries. 
The batteries do not contain any poisonous heavy metals that can damage 
the environment. 

In the interest of recycling, please do not dispose of these batteries in the 
household waste at the end of their useful life. Instead, dispose of them at 
an appropiate collection site. 

Copyright © 2000                      
Remote Technologies Incorporated              
All rights reserved. 

Printed in the United States 
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SAFETY SUGGESTIONS 
Read Instructions. Read all safety and operating instructions before operating the unit. 

Retain Instructions. Keep the safety and operating instructions for future reference. 

Heed Warnings. Adhere to all warnings on the unit and in the operating instructions. 

Follow Instructions. Follow operating instructions and instructions for use. 

Heat. Keep the unit away from heat sources such as radiators, heat registers, stoves, etc., 
including amplifiers that produce heat. 

Power Sources. Connect the unit only to a power supply of the type described in the 
operating instructions, or as marked on the unit. 

Power Cord Protection. Route power supply cords so that they are not likely to be walked 
on or pinched by items placed on or against them, paying particular attention to the cords at 
plugs, at convenient receptacles, and at the point at which they exit from the unit. 

Nonuse Periods. Unplug the power supply from the outlet when the unit is to be left unused 
for a long period.  

Water and Moisture. Do not use the unit near water—for example, near a sink, in a wet 
basement, near a swi
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LIMITED WARRANTY AND DISCLAIMER 
Remote Technologies Incorporated warrants its products for a period of one (1) year from 
the date of purchase from Remote Technologies Incorporated or an authorized Remote 
Technologies Incorporated dealer. 

This warranty may be enforced by the original purchaser and subsequent owners during the 
warranty period, so long as the original dated sales receipt or other proof of warranty 
coverage is presented when warranty service is required.  

Except as specified below, this warranty covers all defects in material and workmanship in 
this product. The following are not covered by the warranty: 

Damage resulting from:        

1. Accident, misuse, abuse, or neglect.       

2. Failure to follow instructions contained in your User’s Guide.   

3. Repair or attempted repair by anyone other than Remote Technologies      
Incorporated. 

4. Failure to perform recommended periodic maintenance.   

5. Causes other than product defects, including lack of skill, competence or 
experience of user. 

6. Shipment of this product (claims must be made to the carrier). 

7. Being altered or which the serial number has been defaced, modified or removed. 

Remote Technologies Incorporated is not liable for any damages caused by its products or 
for its failure of its products to perform, including any lost profits, lost savings, incidental 
damages, or consequential damages.  

Remote Technologies Incorporated is not liable for damages based upon inconvenience, loss 
of use of the product, loss of time, interrupted operation, commercial loss, any claim made 
by a third party or made by you for a third party.   

Remote Technologies Incorporated’s liability for any defective product is limited to repair or 
replacement of the product, at our option.  

If your TheaterTouch system controller needs service, please contact Remote Technologies 
Incorporated by telephone, fax or E-mail for return information (See Chapter 9). Please do 
not return products to Remote Technologies Incorporated without return authorization. 

All rights are reserved. No part of this document may be photocopied, reproduced, or 
translated without the prior written notice of Remote Technologies Incorporated. 

The information contained in this document is subject to change without notice. Remote 
Technologies Incorporated shall not be liable for errors contained herein or for consequential 
damages in connection with the furnishing, performance, or use of this material.  

Microsoft and Windows are registered trademarks of Microsoft Corporation. Other brands 
and their products are trademarks or registered trademarks of their respective holders. 

TheaterTouch, TheaterTouch Designer and the RTI logo are registered trademarks of Remote 
Technologies Incorporated. 
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Chapter 1. Welcome 

Congratulations on your purchase of the TheaterTouch universal system controller. 
The TheaterTouch combines the power and flexibility of a graphic LCD touchscreen 
with an ergonomic design that permits effortless one-handed operation. This design 
overcomes the need for compromise between form and function. Sleek and perfectly 
balanced, the TheaterTouch is infinitely flexible and expandable. 

TheaterTouch takes complete control of the home theater, replacing all other remotes. 
It features an intuitive, easy to read LCD that can display custom buttons, text, 
graphics and symbols. In addition to the backlit display, 25 “Hard” keypad buttons 
allow easy access to frequently used functions. 

Programming is easy and convenient thanks to the built-in infrared learning ability 
and the Windows® based software. TheaterTouch is capable of both infrared and 
radio frequency output. A separate RF to IR converter is available for transmission 
through walls and cabinets. The converter will also monitor the power status of most 
A/V equipment thru the use of voltage and video sensors. 

 

NOTE 
The TheaterTouch and TheaterTouch Designer software are compatible with infrared 
(IR) commands with carrier frequencies between 15kHz and 460kHz, as well as those 
commands that do not use a carrier. This covers the vast majority of remotes 
available to date, including Bang & Olufsen® (most of which use 455kHz) and 
Vidikron® (some of which use 333kHz). 

Despite every effort to make the TheaterTouch universal system controller work with 
all IR-systems, some IR-controlled products are unable to be learned by the 
TheaterTouch due to incompatible frequencies or non-standard IR formats. The 
TheaterTouch cannot learn non-IR formats such as RF and ultrasonic. 

 

UNPACKING AND INSPECTION 
After unpacking your new TheaterTouch universal system controller, save all of the 
packing materials in case you ever have to ship the unit. 

Thoroughly inspect the TheaterTouch and packing materials for signs of damage. 
Report any damage to the carrier immediately. Report any equipment malfunctions 
to Remote Technologies Incorporated or an authorized Remote Technologies 
Incorporated dealer. 

 

IMPORTANT 
After unpacking your new TheaterTouch universal system controller for the first time, 
charge each battery pack for at least 12 hours.  
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PRODUCT CONTENTS 
 

Contents within the box include the following items: 

• TheaterTouch™ System Controller 

• Smart battery charger 

• Two (2) rechargeable Nickel Metal-Hydride battery packs 

• Wall-mount power supply for battery charger 

• TheaterTouch Designer™ software CD-ROM 

• Serial cable for programming 

• Owner’s Manual 

• Warranty card  

• Registration card 

 

SOFTWARE REQUIREMENTS 
 

TheaterTouch Designer software minimum system requirements: 

• Windows 95, Windows 98,Windows NT 4.0 or higher 
operating system 

• IBM or compatible PC with 486DX2/66Mhz or higher 
processor  

• 16 Megabytes (MB) of RAM  

• 8 Megabytes of free disk space for minimum installation    
(16 MB recommended) 

• A mouse or other pointing device is required 

• VGA monitor (256 color Super VGA recommended) 

• CD-ROM drive 

• Open RS-232 serial port  

• Optional printer for printing setup reports 
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Chapter 2. Introduction 

The TheaterTouch is a programmable touchscreen computer that is designed to 
provide wireless control of audio/video and automation systems. Like other 
“universal” or “learning” remote controls, the TheaterTouch allows you to consolidate 
the functions of many independent infrared remote controls into one unit. The 
TheaterTouch also incorporates a unique programmable user interface, allowing it to 
provide a simple, intuitive, and customized interface for any system. Before using the 
TheaterTouch, please read and follow all instructions in this manual.  

 

FEATURES 
The TheaterTouch provides superior quality and reliability as well as these specific 
features: 

• A replacement for all of your system’s remote controls. The TheaterTouch can 
reproduce all of the commands of almost any other infrared remote control. 

• A programmable graphic display. The TheaterTouch uses powerful Windows  
based software that makes it easy to place buttons, text, graphics and symbols 
anywhere on the display. 

• A backlit LCD with digital matrix touchscreen. When you want to perform a 
command, simply touch the display where that command is displayed. The 
touchscreen never needs calibrating. 

• 25 backlit “hard” keypad buttons that allow easy access to frequently used 
functions. 

• Two detachable, low-profile rechargeable battery packs. The TheaterTouch can 
run continuously for several hours between charges. Because the remote is 
normally used only a few minutes per session, the unit typically will run for a 
week or more between charges. A built-in low battery indicator warns you 
when it’s time to recharge the battery. 

• A macro function. This feature allows the TheaterTouch to perform a series of 
commands by pressing a single button. For example, you can create a macro 
called “Movie” that turns on the TV, sets the correct channel, turns on the 
VCR, dims the lights, and starts playing a movie.                                                                       

• Two output options for controlling your equipment: infrared (IR), radio 
frequency (RF), and the ability to use both in the same system.  

• Automatic power on and off. The TheaterTouch turns itself off whenever it is 
not used for a pre-set amount of time. Touching any area of the display or a 
hard button will turn it on again, also a built in tilt sensor can turn the unit on 
when it is picked up. 
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• A serial port for communication with the TheaterTouch Designer programming 
software. 

• Non-volatile flash memory. The TheaterTouch will not lose any programmed 
data when the batteries are exchanged. 

• One-year parts and labor warranty. 

 

 

IMPORTANT NOTES 
 

Please read these important notes about the TheaterTouch:  

• The TheaterTouch should be placed in an area where it is around normal room 
temperature (between 60°F to 90°F). If the temperature is too hot, the display 
appears dim. If the temperature is too cold, the display appears dark and may 
respond slowly. 

• Do not use sharp objects on the touchscreen. It is designed to operate with a 
touch of your finger. 

• Do not let the TheaterTouch get wet. It should not be handled with wet hands 
or placed in an area where it could get wet. 

• Do not subject the TheaterTouch to smoke, dust, or vibrations. The display may 
be damaged from excessive shock or vibration. 

• Use only the power supply that is provided with the TheaterTouch. Using the 
wrong type of power supply may result in battery leakage or other damage. 

• Do not disassemble the unit. The TheaterTouch contains high voltage circuits 
that may cause injury if contacted. 

 

CLEANING 

 
Occasional cleaning may be required, depending on use. 

To clean your TheaterTouch: 

1. Remove the battery pack from the TheaterTouch. 

2. Lightly dampen a lint-free cloth with water or mild detergent and wipe the 
touchscreen, keypad and outer surfaces. 
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BATTERIES AND CHARGER 
 

The following recommendations will assure the best battery performance. 

1. Operate the unit until you receive a Low Battery warning in the upper left 
hand corner of display. 

   

                                

 

2. At that point, you will have approximately 10 - 20 minutes of run time 
remaining before the unit shuts down. At any point after the Low Battery 
icon appears, you can exchange the depleted battery with a charged battery 
from the charger. If you operate the battery past a usable level, you will 
receive a warning stating Battery must be recharged. 

             

                                   

 

To recharge a battery pack, insert the end of the battery with the contacts into the 
charger first, and then gently pushing the end with the clip until it snaps into place. 
The light on the charger will start flashing after a couple of seconds. 

    

Charging Status
Light

(1)

(2)

 
 

Recharge the TheaterTouch batteries for about 3-4 hours. (The light on the battery 
charger will stop flashing and stay on when the charge cycle is completed). 

The batteries can remain in the charger indefinitely without damage to the batteries.  
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Custom Installation Note: 
The TheaterTouch battery charger’s power can be hardwired through the back of the charger 
for permanent mounting on a wall or other flat surface. This is done by removing the 
bottom plate of the charger and hard wiring the wall mount power supply directly to the 
terminal strip. Replace the bottom plate before mounting. 

Use only the original power supply. 

 

                    

J2

Power Connection - (J2)
9VDC 0.5A

Battery Charger with bottom plate removed.
 

 

 

 

GETTING STARTED 
Start by snapping a fully charged battery on the back of the TheaterTouch. This is done by 
inserting the end of the battery with the contacts in first, and then gently pushing the end 
with the clip until it snaps into place.  

     

(1)

(2)

 

 

The TheaterTouch is powered-up by touching any area of the display or any keypad button as 
well as picking up the unit if the tilt sensor is active. 

 

 Warning! Watch the polarity. 
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REMOTE REFERENCE 
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THE TOUCHSCREEN DISPLAY 
 

The TheaterTouch touchscreen display is organized as a series of pages and frames. A 
page can consist of up to 12 frames of information having one frame displayed on the 
screen at a time.  

Normally each frame on a page contains objects (buttons, text, graphics, and 
symbols) that are related in some way. For instance, they may all display information 
necessary for controlling a particular VCR. 

By default, the TheaterTouch has one Main Menu page—all other pages are 
considered submenus. Any page can contain a button that will display any other 
page when selected.  

Normally the Main Menu page is used to display the names of the submenus (e.g., 
the equipment being controlled). The submenus may consist of one or more pages. 
The TheaterTouch will support 63 pages plus the Main Menu page; each page can 
consist of up to 12 frames.  

 

A representation of a programmed Main Menu page is shown below. 

 

                            

 

Pressing the Main Menu key at any time will return you to this page (unless a 
different page is assigned using the TheaterTouch Designer software). 

THE CONTROL PANEL PAGE 
 

The Control Panel page can be displayed by pressing and holding the backlight key 
for at least 3 seconds.  

You can also access the Control Panel page by assigning a “Control Panel” page link 
to a button using the TheaterTouch Designer software. 
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The Control Panel consists of the following three frames: 

 

                                                                           

 

 

To change frames, press the frame Left  or frame Right  buttons on the 
bottom of the touchscreen. 

To return to your TheaterTouch program, press the Main Manu key.                                  

 

 

 

ADJUST CONTRAST 

 

This button displays a window that allows you to adjust the LCD contrast. 
Press the Left Arrow or Right Arrow keypad buttons to adjust. Press the OK 
button in the window to close. 
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BEEPER 

 

This button displays a window that allows you to turn the audible beep on or 
off. The beeper provides feedback that a button was pressed. Press the OK 
button in the window to close. 

                                  

                                   

 

 

 

TIME OUT 

 

This button displays a window that allows you to adjust the amount of time 
the unit stays awake after the last button press. The time is variable from 1 
second to 60 seconds (default is 10 seconds). Press the arrows to the left or 
right of the Time Out setting to adjust the time. Press the OK button in the 
window to close. During Sleep mode, the TheaterTouch uses virtually no 
battery power. 
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TILT SWITCH 

 

This button displays a window that allows you to adjust the settings for the 
built in tilt switch, which is a device that turns the remote on when tilted past 
a 45 degree angle.   

On means the tilt switch is active and will turn on display and backlight 
when picked up.  

Off means the tilt switch is inactive.  

Press the OK button in the window to close. 

 

                                        
 

 

 

PROGRAM LOCKOUT 

 

This button displays a window that allows you to turn the program lockout 
feature on and off. This is used to lockout un-authorized users from the 
Computer Link mode, so that the program cannot be altered. 

If the Lockout feature is enabled, you will need to enter the current passcode 
before you can change this setting. 

On means the Computer Link mode is locked and can only be accessed with 
the passcode. 

Off means the Computer Link mode is unlocked and can be accessed without 
a passcode. 

Press the OK button in the window to close. 
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CHANGE PASSCODE 

 

This button displays a window that allows you to set the passcode that is 
used to limit access to the Computer Link mode and Clear All function on 
the control panel page, as well as the Button Lockout function that is 
available on all buttons. 

 

When you press the Change Passcode button, the screen will prompt you to 
enter the old passcode using the hard keys, then press the Enter key on the 
keypad.  

(The default code is 0000).  

      

Now enter a new four-digit passcode, then press Enter. 

       

You will be prompted to enter the new four-digit passcode again for 
confirmation, then press Enter.  

                              

When new code is entered successfully, the Code Changed window 
will pop up to let you know you have changed the passcode. 

               

Do not forget the passcode!    
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COMPUTER LINK 

 

This button displays a window that allows you to put the TheaterTouch into 
Computer Link mode.  

This is used for RS-232 communications between a personal computer and the 
TheaterTouch for loading a program into the TheaterTouch or extracting a 
program from the TheaterTouch.  

 

The two options available for the transfer of a program in the TheaterTouch 
Designer software are: 

  

♦ Send File to Remote, which sends the new program from the software 
to the remote, overwriting the existing program.  

♦ Receive File from Remote, which extracts a copy of the program from 
the remote to the software, leaving the program in the remote intact.  

Press the OK button to close the window after the transfer is complete.  
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IR CAPTURE 

This button displays a window that allows the TheaterTouch to align, learn, 
and test infrared commands from donor remotes. Used together with the 
TheaterTouch Designer Infrared Library Manager software you can create a 
custom database of infrared commands.  

 

                                        
 

The use of the IR Capture command is described in chapter 6 “IR Library 
Manager”.  

To exit IR CAPTURE mode, press the Main Menu button on the remote.  

 

CLEAR ALL 

This button displays a window that will allow you to erase the current 
program in the TheaterTouch remote. When the button is pressed, you will be 
prompted to enter the current passcode. If the proper code is entered, the 
entire program in the TheaterTouch will be erased. 

 

                                          
 

Warning!  This will erase the complete program in the TheaterTouch with no 
way to restore it, except by reloading the program from the TheaterTouch 
Designer software! 

 

If you inadvertently press the CLEAR ALL button, simply press the ENTER 
button without entering the passcode and you will be returned to the Control 
Panel page.                                     
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Chapter 3. TheaterTouch Designer  Software      

TheaterTouch Designer allows you to create the entire graphical interface for an RTI 
TheaterTouch System Controller on your computer.  Once the interface has been 
created, it is downloaded to the TheaterTouch using the included programming cable.  
Existing programming can also be extracted, modified, and re-sent to any 
TheaterTouch system controller. 

Software updates will be available for download at www.rticorp.com 

INSTALLING THEATERTOUCH DESIGNER  
1. Close any open programs.  

2. Place the TheaterTouch Designer compact disc into the CD- ROM drive. 

3. If the installation doesn’t appear automatically, click Start and choose 
Run, type d:\setup\setup.exe (For d, type the letter for your CD-ROM 
drive). Click OK.   

4. Follow the on-screen instructions. 

 

PROGRAMMING OVERVIEW 

  

Here is an overview of the process of programming a TheaterTouch from scratch. 

Instructions on carrying out these tasks can be found in chapters 4 and 5.   

1. Create a new page and add buttons for each source component in a 
system. 

2. Place a button on the main menu to access each one of the source 
components. 

3. Use the Assign Page tool to link the buttons on the main menu to their 
respective source component pages. 

4. Assign infrared codes and other commands to buttons using the 
Command Library. 

5. Create macros using the macro editor (if needed). 

6. Check the Remote Properties. 

7. Save the file. 

8. Send the file to the TheaterTouch using the communications commands. 
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THEATERTOUCH DESIGNER SCREEN 
 

 

 

 

 

      

 

 

Menu Bar 

Toolbar Page List 

Tool Palette 

Touchscreen 
grid 

Design Window 
 

 

 

 

 

 

Keypad Buttons Frame Left and 
Right arrows 
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TOUCHSCREEN GRID 
 

The touchscreen grid is where the buttons, text, graphics and symbols are placed. 
Click on the frame Left  or frame Right  buttons at the bottom of the 
touchscreen grid to place buttons on other frames.   

      

                        

 

 

DESIGN HINTS 
 

1. Be consistent with the location of similar buttons.  For example, if you 
have a DVD player and a VCR in your system, try to make the transport 
controls (Play, Pause, Stop, etc.) on both pages look similar. 

2. It’s not necessary to re-create each donor remote in its entirety on the 
TheaterTouch.  Think of the functions the user will be using daily. 

3. Use macros to hide complex command sequences from the user.  For 
example, instead of presenting the user with only the key pad for 
changing channels on their TV, make a set of macros for CBS, HBO, etc. 
that send the proper channel numbers automatically.  The Channel Macro 
Wizard makes it easy to create this type of macro. 
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GETTING HELP 
 

TheaterTouch Designer includes an extensive on-line help system. If you need help 

with any tool or command, click the What’s this?  button on the Toolbar. 

If you need an explanation of any item in a dialog box, click the Help  button in 
the dialog’s title bar, and then click on the control you would like to learn about. 
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Chapter 4. TheaterTouch Designer Basics 

The TheaterTouch system controller is divided into two sections: the touchscreen and 
the keypad. You can assign commands, macros and page links to any button you 
create on the touchscreen or on the keypad buttons.   

The keypad button layout of the TheaterTouch follows the pages, not the frames, so all 
12 frames of a page will have the same commands, macros and page links on the 
keypad buttons. Each frame of the touchscreen can have different commands, macros 
and page links. 

 

PAGES 

 

The individual screens on the TheaterTouch system controller are called pages.  Pages 
on the touchscreen can contain buttons, links to other pages, a title, text, commands, 
and macros.   

The page links, commands and macros associated with the keypad buttons on the 
TheaterTouch are also stored with each page.   

Each page can have up to 12 frames on the touchscreen, and usually has the controls 
for just one component. Each frame is accessed by scrolling left and right with the 
arrows at the bottom of the TheaterTouch touchscreen.  With TheaterTouch Designer, 
you can add and delete pages, duplicate pages, etc. 

All TheaterTouch pages have a page title. The page title is the name that appears in the 
title bar above the touchscreen grid and in the Page List. 

 

HOW TO ADD A PAGE 

1. Click the Create New Page Command  on the Toolbar. 

2. Enter a name for the page in the New Page Title dialog, this is usually the 
name of the component, such as: CD, Satellite, Lights and so on. 

3. Click OK. 

Repeat this procedure for each page you wish to add. 

 

HOW TO DELETE A PAGE 
 

1. Select the page to be deleted from the Page List. 

2. Click the Delete Current Page Command  on the Toolbar. 

3. Click Yes in the Delete Page confirmation box. 



TheaterTouch System Controller 

20 

BUTTONS 

 

Buttons are the functional elements of the TheaterTouch system controller.  Each 
button can be associated with commands, macros, and page links. Creating buttons 
in the touchscreen grid consists of making the button itself and then adding text, 
bitmaps, or symbols to them. 

 

HOW TO ADD BUTTONS 
 

1. Select a page from the Page List, and then the frame on that page with the 
frame left and right arrows on the bottom of the touchscreen grid. 

2. Select the style of button from the button drawing tools on the left side of 
the Tool Palette. 

3. Place the mouse cursor over the cell in the touchscreen grid where one 
corner of the button will be. 

4. Click and hold the left mouse button and drag the mouse to the opposite 
corner of where the button will be. 

5. Release the left mouse button when the button has the desired shape and 
size. 

Repeat this procedure for each button you wish to add. 

 

HOW TO DELETE BUTTONS 
 

1. Select the Delete Button tool  from the Tool Palette. 

2. Place the mouse cursor over the button to delete. 

3. Click the left mouse button. 
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HOW TO ADD TEXT TO BUTTONS 
 

1. Select the Edit Text tool  from the Tool Palette. 

2. Place the mouse cursor over the button you want to add or edit text on. 

3. Click the left mouse button. 

 

 
 

4. Enter the text in the Edit Button Text dialog and click OK. 

You can use any of the options in the Edit Button Text dialog to customize the 
button. 

 

 Make the text bold. 

 Justify the text to left side of the button. 

 Center the text horizontally in the button. 

 Justify the text to the right side of the button. 

 Shift the text to the top of the button. 

 Center the text vertically in the button. 

 Shift the text to the bottom of the button. 

 Enable the auto-complete feature, which will automatically finish               
 typing the name for commonly used buttons. 

 

Click on any of the symbols at the bottom the dialog box to insert them into the active 
line.      
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HOW TO PLACE A BITMAP  
 

The Bitmap Library window allows you to assign bitmaps to buttons in your file or 
to create new bitmap buttons by dragging the bitmaps from the Bitmap Library to 
the touchscreen grid. Hold the mouse over any bitmap in the Bitmap Library 
window to see its title and the Bitmap Library it is stored in. 

If you drop the bitmap onto an empty section of the touchscreen grid, a new button is 
automatically created with the default style, and the bitmap is placed on that button.   

If you drop the bitmap onto an existing button, any text or bitmap already on that 
button is replaced with the bitmap that you drop. 

 

1. Select the Place Bitmap tool  on the Tool Palette.  

2. When the Bitmap Library window appears, drag any bitmap from the 
Bitmap Library onto the touchscreen grid.  
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HOW TO LINK PAGES 

 
The TheaterTouch Designer software gives you the ability to link pages. When a button 
with a page link is pushed on the TheaterTouch, the linked page becomes active, in 
essence turning the page. 

Page links are indicated by a small green box containing the number of the linked-to 
page in the lower left corner of the button. 

 

1. Select the Assign Pages tool  from the Tool Palette. 

2. Place the mouse cursor over the button to which you wish to assign a 
page. 

3. Click the left mouse button. 

4. Select the page name you wish to link to from the pop-up menu. 

                      

 

5. Notice the green square in the lower left corner of the button corresponds 
to the linked page in the list. 

     

 

Two additional options are available for linking: 

♦ <previous> will take you back to the last page that was displayed. 

♦ <control panel> will switch to the built-in Control Panel page.  

 



TheaterTouch System Controller 

24 

HOW TO REMOVE PAGE LINKS 

 

1. Select the Assign Pages tool  from the Tool Palette. 

2. Place the mouse cursor over the button from which you wish to remove 
the page link. 

3. Click the left mouse button. 

4. Select the <none> item from the bottom of the pop-up menu. 

 

 

 

HOW TO ADD COMMANDS TO BUTTONS 
 

IR commands are indicated by a small red box with the letter ‘C’ in the upper right 
corner of buttons. 

 

1. Select the Command Library tool  from the Tool Palette. 

2. Click the Select New Remote button in the Command Library window to 
select a different remote than displayed. 
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Remotes are listed by manufacturer, type, and model in the Select Remote from 
Library window; use this to select the remote you would like to assign codes from.  

Remotes that have already been used in the current remote file will be moved to the 
top of the list and their icon will turn red for easy identification. 

 

3. If the remote is in a different library or no library is open, click on the 
Open Library button to find the library you are looking for. 

4. Click on the remote you would like to assign codes from and the 
Command Library will open again.  

5. Place the mouse cursor over the function in the Command Library that 
you want to assign. 

6. Click and hold the left mouse button. 

7. Drag the mouse cursor to the button on which you want to place the 
command. 

8. Release the left mouse button. 

 

If you drag a command to a spot on the touchscreen grid where there are no buttons, 
TheaterTouch Designer will automatically create a button and insert the text for that 
command. 
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HOW TO DELETE COMMANDS FROM BUTTONS 

 

1. Select the Delete Command tool  from the Tool Palette. 

2. Place the mouse cursor over the button with the command you wish to 
delete. 

3. Click the left mouse button.  

 

 

 

HOW TO SAVE A FILE 
 

The files created with TheaterTouch Designer hold all the elements that make up an 
individual remote file. They have the extension .rti and may be stored in any 
directory. 

Default directory is: [C:\Program Files\TheaterTouch Designer\My Remotes] 

Note: If a file already exists on the disk, the current copy is backed up in a file 
with the extension .rtb and the new file is saved with the .rti extension. 

 

1. Click the Save File Command  on the Toolbar. 

2. Specify the name and directory for the file when saving for the first time 
and click Save. 

 

 

 

HOW TO OPEN AN EXISTING FILE 
 

1. Click the Open File Command  from the Toolbar. 

2. Click on the file you wish to open. 

3. Click Open. 
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HOW TO PREVIEW YOUR FILE 
 

The Preview mode in TheaterTouch Designer allows you to see exactly what your file 
will look like when it is sent to the TheaterTouch remote. 

 

Click the Preview Mode Command  from the Toolbar. 

 

 

 

Use the mouse to press the buttons in the preview window.  The buttons will 
push-in just like they would on the TheaterTouch, and if they are linked to another 
page, the linked page will become the current page in the Preview Window. 

Click the Preview Mode Command  from the Toolbar again when you are 
finished testing your file. 
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HOW TO SETUP COMMUNICATIONS  
 

The Communications Setup dialog box is for setting up communications between 
the TheaterTouch and your PC. 

To open the Communications Setup dialog box: 

Choose Set COM Port from the Options menu. 

 

 

 

Com Port group box - Choose the COM Port that the TheaterTouch is connected 
to. 

 

Auto Detect - Click this button to have TheaterTouch Designer attempt to 
automatically locate the correct COM port. The TheaterTouch must be connected to 
the computer with the programming cable and in Computer Link mode, if you 
need help with Computer Link mode see the Control Panel section on page 8. 

 

Maximum Comm Speed - Choose a lower speed from this list if you are having 
problems communicating with the TheaterTouch system controller. The default is 
High. 
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HOW TO SEND A FILE TO THE THEATERTOUCH 
 

1. Hook the Programming Cable from the TheaterTouch serial port to the desired 
COM port on your computer if you have not done so already. This should be 
the COM port you set up using the Communications Setup dialog. 

 

To Computer
COM Port

TheaterTouch
Serial Port

Programming  Cable

To Computer
COM Port

Programming  Cable

TheaterTouch
Serial Port

 
 

2. Put the TheaterTouch in Computer Link mode. If you need help with 
Computer Link mode, see the Control Panel section on page 8. 

3. Click the Communications Command  on the Toolbar. 

4. Choose Send File. 

 

All buttons, commands, bitmaps, and macros are sent.  Any existing program in the 
TheaterTouch is replaced with the file you send. 

All communications take place on the COM port selected with the Set COM Port 
command from the Options menu. 
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Chapter 5. TheaterTouch Designer Advanced Features 

 

HOW TO RENAME A PAGE 
 

1. Make sure the desired page is displayed in the touchscreen grid. 

2. Select the Edit Text tool  from the Tool Palette. 

3. Place the cursor over the page title area at the top of the touchscreen grid 
and click the left mouse button. 

4. Specify the new page title and click OK. 

 

HOW TO DUPLICATE A PAGE 

 

Pages can be instantly duplicated.  This is useful when pages share common buttons 
like channel macros or transport controls.  One page can be created with these 
buttons and duplicated as many times as needed. 

1. Make sure the desired page to be duplicated is displayed in the 
touchscreen grid. 

2. Click the Duplicate Page Command  on the Toolbar. 

3. Give the new page a different name and click OK. 

The new page appears at the end of the page list. 
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HOW TO MERGE PAGES 
 

The Merge Pages dialog makes it possible to move groups of pages from another .rti 
file to the current remote file. 

1. Click the Merge Pages tool  on the Toolbar. 

2. Select the remote file from which you wish to merge pages from. Choose 
from the list located in the Select file to merge from dialog box and click 
Open. 

 

 

 

3. Place a check next to each page you would like to merge into the current 
file. 

4. You can click the frame left and frame right arrows to see the individual 
frames on a page. 

5. When finished selecting pages, click OK. 

 

All of the marked pages in the list are placed at the end of the current file. 
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HOW TO USE THE PAGEWIZARD 
 

TheaterTouch Designer comes with a library of pre-built pages for many common 
types of equipment that you can insert into your file and customize as desired.  The 
page library is accessed through the PageWizard tool. 

 

To add a pre-built page to your file: 

1. Click the Page Wizard Command  on the Toolbar. 

 

 

2. Scroll through the list of available pages and select the one you want.  You 
can use the Next Page and Prev Page buttons to see previews of all the 
pages if there is more than one. 

3. Click the Insert button to add the page(s) to your file.  

4. Click the Close button to close the dialog box. 

The new page(s) appear at the end of the page list. 

Use the editing tools to customize the button style to fit the rest of your file and to 
place commands, page links and macros on the buttons. 

 

HOW TO CHANGE BUTTON STYLES 
 

1. Select the style of button from the Tool Palette.  

2. Place the mouse cursor over the button you wish to change. 

3. Click the left mouse button. 
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HOW TO SELECT BUTTONS 

The Select Button tool  is used to select buttons for cutting, copying, moving, 
resizing, or property editing.  When buttons are selected, they are painted in red. 

To select a single button or a group of buttons next to each other:  

1. Click the Select Button tool  on the Tool Palette. 

2. Place the mouse over one corner of the button(s) and click the left mouse 
button. 

3. Draw a rectangle around the buttons you wish to select in the design 
window (either in the touchscreen grid or the keypad buttons). 

  

To select multiple buttons at one time that are not next to each other: 

1. Click the Select Button tool  on the Tool Palette. 

2. Hold down the Ctrl key on your keyboard. 

3. Click the buttons you wish to select (either in the touchscreen grid or the 
keypad buttons). 

Note: Many TheaterTouch Designer commands can be used on selections as well as 
individual buttons. Click the right mouse button on a selection for a list of available 
commands. 

 

HOW TO CUT OR COPY BUTTONS 
 

1. Use the Select Button tool  from the Tool Palette to select the 
button(s).  

2. Choose either the Cut Command  or the Copy Command  from the 
toolbar. 

3. The button(s) are now on the clipboard. 

  

 

HOW TO PASTE BUTTONS  
 

1. Select the page you want to paste the button(s) on from the page list. 

2. Choose the Paste Command  from the Toolbar. 

3. Drag the button(s) to the proper place on the page. 



Chapter 5 • TheaterTouch Designer Advanced Features 

35 

HOW TO MOVE A BUTTON 

1. Use the Select Button tool  from the Tool Palette, to select the 
button(s).   

2. Hold down the left mouse button to drag the selection to a new location. 

3. Release the left mouse button to place the buttons. 

 

HOW TO RESIZE A BUTTON 

 

Existing buttons on the touchscreen grid may be re-sized using TheaterTouch Designer.  
The text on a button may be clipped if the size is reduced, but any associated 
command or macro will not be lost. 

1. Use the Select Button tool  from the Tool Palette to select the button.  
Note that to resize a button, only one button can be selected.  If the 
selection can be resized, small boxes will appear in the red border on all 
four sides. 

2. Position the mouse over the edge of the button that you would like to 
resize. 

3. Click the left mouse button. 

4. Drag the mouse to change the size. 

5. Release the mouse button when you have the desired size. 

 

HOW TO PLACE A CUSTOM BUTTON 
 

The Custom Button Library Browser allows you to select and place Custom Buttons 
onto the touchscreen grid. 

1. Select the Place Custom Button tool  from the Tool Palette. 

2. Select the library in which the custom button you want is located by 
clicking the Open Library button, selecting the library and clicking Open. 

Default directory is: [C:\Program Files\TheaterTouch Designer\Custom Buttons]  

3. Click on a button name and a preview of the button will appear in the 
Custom Button Library Browser. 

4. Click OK to insert the custom button on the touchscreen grid and close 
the Custom Button Library Browser. 

5. Drag the custom button to the proper place on the page. 
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HOW TO USE THE MACRO EDITOR 
Macros are a sequence of commands placed on any single button. Macros are placed 
by using the Edit Macro command found on the Tool Palette.  

Buttons with macros can be moved, cut, copied, and pasted to other pages without 
discarding the codes attached to them. 

Macros are indicated by a small black box with the letter ‘M’ in the upper left corner 
of buttons. 

 

EDITING MACROS 

To add a new macro or edit an existing macro on a button: 

1. Select the Edit Macro tool  from the Tool Palette.  

2. Click the button to which you would like to add a new macro or edit an 
existing macro. 

3. Use the tools in the Macro Editor window to add, insert, and delete 
commands. 

4. Click OK in the Macro Editor window to save changes to the macro, or 
click Cancel to discard them. 
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Report command – The Report command button at the bottom of the macro editor 
opens up your default web browser for viewing and printing of the open macro.  

 

Trash Can – The Trash Can located at the bottom of the macro editor is used to 
delete commands from a macro. Left click and hold the command you want to delete 
and drag it to the Trash Can and release. 

 

 The Infrared from Library macro step type causes the macro to 
output an Infrared command.  Any number of Infrared commands can be added to 
the macro by selecting the proper library and then dragging the desired function(s) 
from the list on the right side to the macro display on the left side of the Macro 
Editor.  

If you do not have access to the Command Library with the desired function, but it is 
assigned to a button in the current file, use the Infrared from Page step type to add it 
to the macro. 

Double-click the infrared command step in the macro if you need to edit any of the 
parameters or to change which IRF-6 the command is output if you are using more 
than one. 

 

 

 The Infrared from Page macro step type causes the macro to 
output an Infrared command.  The command is taken from a button in the current 
file.  Select the page containing the desired code, and then drag the code from the 
Available Buttons list on the right to the macro display on the left. 

This should be used for maintaining files for which the Command Library is not 
available.  If the desired command is in a Command Library, use the Infrared from 
Library step type. 

Double-click the infrared command step in the macro if you need to edit any of the 
parameters or to change which IRF-6 the command is output if you are using more 
than one. 

 

 

 The RS-232 Command step causes the macro to output an RS-
232 command when the TheaterTouch is used in RF mode with an optional IRF-6 
System Interface Module and an optional RS-232 Communications Module.  The 
command structure (Baud Rate, Parity, Data Bits, Stop Bits, IRF-6 output, and 
Command String) is created for the particular piece of equipment with the editing 
tools provided. The command structure information should be in the equipment 
owners manual or contact the equipment manufacturer.   
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The default settings for Parity, Data Bits and Stop Bits should work in most cases if 
not listed in the equipments owners manual. However, you will need at least the 
Baud Rate and Command String for that particular piece of equipment and the 
command you are to execute. 

After you have set the desired parameters and entered the command string, drag the 
RS-232 icon from the lower right to the macro display on the left. Release the mouse 
button at the location where you would like to add the RS-232 step. 

Double-click the RS-232 command step in the macro if you need to edit any of the 
parameters or to change which IRF-6 the command is output if you are using more 
than one. 

 

 

 

 The Time Delay step causes the macro to pause for the time 
specified by the Delay Time spin box. The time can be adjusted from 0.1 to 9.9 
seconds. After you have set your desired delay time, drag the Time Delay icon from 
the lower right to the macro display on the left.  

Release the mouse button at the location where you would like to add the time delay 
step.  
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 The Button Test step causes the macro to execute the following 
steps ONLY IF the button that the macro is attached to is Held Down for a specified 
amount of time or Double-Clicked within a specified amount of time, depending on 
the option selected.  

The Button Test steps are conditional statements or “Else” commands meaning that 
if the condition is met the first command will be sent and if the condition is not met 
the second command will be sent.  

 

                           
 

Held Down - In the example above, if the button is held down for 0.3 seconds, the 
ON command will execute. If the button is not held down for 0.3 seconds, the 
command will not execute. 

This can be used to make a source button that switches pages if pressed briefly, or 
switches pages and turns equipment on if held down for the specified amount of 
time. This can also be used to send a command when pressed briefly, or send a 
different command when held down.  

 

 

 

Double-Clicked – In the example above, if the button is double-clicked within 0.3 
seconds, the ON command will execute. If the button is not double-clicked within 0.3 
seconds, the command will not execute. 

This can be used to make a source button that switches pages if pressed once, or 
switches pages and turns equipment on if double-clicked within the specified 
amount of time. This can also be used to send a command when pressed once, or 
send a different command when double-clicked. 
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 Button Pause – The Button Pause step causes the macro to stop 
executing until the button it is attached to is released. This essentially sends a 
command(s) when the button is pressed and another command(s) when the button is 
released.  

 

 
  

In the example above, if you press and hold the button that the macro is attached to, 
the macro will execute the first command and pause until the button is released, then 
execute the rest of the commands in the macro. This works well for commands like 
Scan on some VCR’s and DVD players, which you need to send the Play command to 
stop the Scan function. This also works well for RS-232 commands, having the option 
of a command on the button press and another command on the button release.  

 

 Page Link – The Page Link step causes the macro to change the 
currently displayed page to the page you have selected from the drop-down list. The 
displayed page does not change until the macro has finished.   

If you put multiple Page Link steps in a macro, only the last Page Link step will be 
displayed. With the exception of the <previous> page step, there is no need to put 
multiple Page Links in a macro. Each <previous> step will cause the macro to go 
back one previously displayed page. 

If you have put a Page Link on a button as well as in a macro, the Page Link on the 
button will be the last visible change, making the Page Links in the macro useless.  

 

   
 

Shown in the example above is one way you could make one button go to two 
different pages using the Page Link step with the Button Test step in a macro. 
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 Stop Macro - The Stop Macro step causes the macro to stop 
executing at the point where it is inserted. 

Macros automatically stop when they reach the end, so you should not normally 
need to insert a Stop Macro step.  It is intended for use in conjunction with the Button 
Test step, where you can have the macro stop if a condition is met. 

 

 Toggle IR Code - The Toggle IR Code step causes the macro to 
alternate between two different IR codes every other time the button is pressed. 

 

 
 

In the example above, each time the button that the macro is attached to is pressed, 
the commands alternate. The initial button press executes the A command and the 
second button press executes the B command.  

If you have equipment that uses toggle codes, you must learn each code twice, and 
then place the two codes within the Toggle IR Code step.  Every time the macro is 
run, it will send out only one of the two codes inside of the Toggle IR Code step, 
switching back and forth each time the button is pressed. 

The Toggle IR Code command is an advanced feature. If you have trouble with this 
feature, contact Technical Support for help. 
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HOW TO DELETE A MACRO 
 

To delete a macro from a button: 

1. Select the Delete Macro tool  from the Tool Palette.  

2. Place the mouse cursor over the button with the macro you wish to delete. 

3. Click the left mouse button. 

 

 

HOW TO EDIT AN IR COMMAND IN A MACRO 
 

1. To edit an individual command in a macro you must have the macro 
displayed in the Macro Editor. 

2. Double click on the command in the macro you want to edit to open the 
Edit Infrared Command dialog box.  

Note: Not all of the controls will be available simultaneously.  Only the options 
relevant to the default settings and command being edited will be shown. 
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The Edit Infrared Command options are: 

Minimum Repeats - Enter in this box the number of times that the repeating 
part of the IR code is sent by the remote.  Some infrared receivers need a 
command to be repeated a certain number of times to work properly, and 
some may not work properly if the command is repeated at all.  Even if a 
command works properly, increasing the number of repeat times may be 
necessary if the command is to be used in a macro.  Since macro commands 
are not automatically sustained while a button is pressed, they may need to 
automatically repeat more times to be recognized. 

Frequency – Shown in this box is the carrier frequency of the IR code, this is 
set automatically. You should not need to change this value unless directed to 
do so by Technical Support. 

 

Repeat while button is pressed - Check this box to cause this IR code to be 
repeated for as long as the button is held down.  

Note: Only one command in any macro can have this property set. 

 

 

Output Type: 

Unless the system contains a mixture of direct IR and IRF-6/RF commands, 
this option will not normally need to be changed. 

Default - Check this option to set the default output type for this 
command to the button default.  The button default is the option 
selected on the Output tab of the Edit Button Properties command.   

IR - Check this box to force this command to transmit IR directly out 
the infrared window on the front of the remote, regardless of the 
system setting. 

RF - Check this box to force this command button to transmit IR via RF 
through the IRF-6, regardless of the system setting. 

 

RF ID Code: 

Unless the system contains more than one IRF-6, this option will not normally 
need to be changed. 

Default - Check this option to set the default RF ID code for this 
command to the button default.  The button default is the ID code 
selected on the Output tab of the Edit Button Properties command.   

Code - Check this option and enter an ID Code in the box to force this 
command to transmit a specific RF ID code when in RF mode, 
regardless of the system default setting.   
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IR Outputs group box: 

Check the box(s) that corresponds with the output(s) you wish to send 
the command(s) on this button out of the IRF-6.  Note that the labels 
for the output can be changed with the Edit Remote Properties 
command on the Edit menu. 

The default is to have the command(s) come out of all of the outputs 
on the IRF-6. This option will not normally need to be changed unless 
you have multiple identical components or are using one of the power 
sensor modules. 

 

Send this code group box: 

The options in this section require that a power sensor module be 
plugged into the appropriate port on the IRF-6.  

Always - Check this option to send the IR code regardless of the 
power sensor state.  This option should also be checked if no power 
sensor is connected to the selected IR output. 

Only when device is ON - Check this option to send the IR code only 
if the power sensor in the specified port detects that the equipment it 
is monitoring is ON. 

Only when device is OFF - Check this option to send the IR code only 
if the power sensor in the specified port detects that the equipment it 
is monitoring is OFF. 

Note: In order to use the power sensor options, exactly one IR output 
must be selected in the IRF-6 IR Outputs box, and the power sensor 
must be plugged into that IR output port. 
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HOW TO USE THE CHANNEL MACRO WIZARD 
 

TheaterTouch Designer comes with a feature called the Channel Macro Wizard. The 
Channel Macro Wizard allows you to quickly and easily create macros for satellite 
and cable channel presets. 

 

To start using the Channel Macro Wizard: 

1. Select Channel Macro Wizard from the Edit menu. 

2. Click the Select New Remote button to select the remote that you will use 
to enter to enter the channel numbers and click the Next >> button. 

                         

 

3. You have the option of adding commands before and/or after each macro 
for things such as an IR router before each command or an Enter 
command after. 
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4. Click the Add/Edit in the BEFORE or AFTER section if choose to add 
commands. This will open the Macro Editor where you can select the 
commands using the Macro Editor commands. If you need help with 
these commands, see the “How to Use the Macro Editor” section.  

 

 

                            

 

5. Click the Next >> command button. 

6. Select the page you wish to place macros on from the Page drop-down list 
and then select the frame by clicking on the Left and Right frame arrows. 
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7. Select the number of digits in the channel macro from the Spin box in the 
lower right corner. If you enter more digits than selected the numbers will 
wrap around.  

8. Click the first button from the touchscreen grid on which you want to 
place a macro. 

9. Enter the channel numbers by either clicking the numbers in the Channel 
Macro Wizard with the mouse or you can enter them with the numbers 
on the keyboard. 

10. Click Save after you enter each macro. 

Click Close when finished with all your channel macros. 
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HOW TO EDIT THE REMOTE PROPERTIES 
 

The Remote Properties dialog box allows you to change settings that affect the entire 
remote.  

To open the Remote Properties dialog box: 

Choose Edit Remote Properties from the Edit menu. 

 

POWER TAB 

                                                         

 

 

The Power tab options are: 

Power Down Time: This allows you to adjust the to time the unit stays awake 
after the last button press. The time is variable from 1 second to 60 seconds 
(default is 10 seconds). During sleep mode, the TheaterTouch uses virtually no 
battery power. 

Display Mode: The option buttons allows you to adjust the settings of the display 
and keypad backlight.  

The options are:  

1. Any keypress (default), which turns the display and button backlight on 
when any button is pressed.  

2. Touchscreen or backlight key, which turns the display and button 
backlight on only when the touchscreen or backlight key is pressed.  This 
allows the volume/channel/etc. keys to be used without turning on the 
display and backlight each time. 

Tilt Switch: (default is: active) The Tilt Switch check box allows you to turn the 
tilt switch on or off. When the box is checked, it means the tilt switch is active and 
will turn on the display and button backlight when picked up.      
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MISC. TAB                                   

   

The Misc. tab options are: 

Enable Beeper: Check the box to enable the beeper.  If this box is checked, the 
TheaterTouch will beep every time a button is pressed. 

Scroll Rate: Slide this control to set how fast the frames scroll left and right when 
the frame scroll arrows are pressed. 

 

SECURITY TAB 

                             

The Security tab options are: 

Passcode: (default is 0000) That allows you to set the passcode that is needed to 
limit access to the Computer Link mode, the Clear All function on the control 
panel page as well as the Button Lockout function that is available on all buttons. 

Enable Programming Lockout: Check this box to require that the passcode be 
entered before the TheaterTouch will go into Computer Link mode.  This can be 
used to prevent unauthorized modifications to the TheaterTouch programming. 
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OUTPUT TAB 

 

                                    

 

The Output tab options are: 

Default Output Type:  

1. IR – (default) Check this option to set the remote's default output to IR.  
Every key on the remote will output IR signals directly out the window on 
the front of the remote unless the button properties for the individual 
button are set to output RF. 

2. RF - Check this option to set the remote's default output to RF.  Every key 
on the remote will output IR signals via RF to the IR to RF converter 
unless the button properties for the individual button are set to output IR 
directly. 

Default RF ID Code: Use this to set the default RF ID code.  This RF ID code will 
be used for all RF buttons unless it is set differently in the properties for each 
button.  The ID code switch on the back of the IRF-6 must also be set to this 
setting. 
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IRF-6 TAB 

 

                               

 

 

The IRF-6 tab lets you label the outputs of the IRF-6. Use the pull down list to choose 
the IRF-6 ID code for which you wish to modify the labels. You can modify the labels 
of all ten possible IRF-6 ID codes independently. The labels are optional and are only 
used to make it easier for you to remember what equipment is plugged into each IRF-
6 output. 

Send - Click this button to send the current settings directly to the remote. 
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HOW TO EDIT BUTTON PROPERTIES 
 

The Edit Button Properties dialog allows you to edit many different attributes of a 
button or a group of buttons. 

To open the Edit Button Properties dialog box:  

1. Select the Edit Button Properties tool  from the Tool Palette. 

2. Click the button you want to edit, either touchscreen or keypad buttons   

  

Note: Not all of the tabs and/or controls will be available simultaneously.  Only the 
options relevant to the button being edited will be shown. 

 

GENERAL TAB 

              

 

 

The options on the General tab are: 

Disabled - Check this box to prevent the button from responding (beeping or 
reversing/pushing in) when it is touched. 

Note: Disabled buttons can still have commands, macros and page links.  The 
disabled property refers only to the appearance of the button, not the 
functionality. 

 

Reversed - Check this box to cause the button to be displayed in a reversed or 
pushed-in state when the button is not pushed and the normal state when the 
button is pushed.  The reversed state is: filled in for Rectangular, Radius, Oblong 
and Borderless buttons; and Down for Custom Buttons. 

Note: This property does not apply to 3D buttons. 
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Secured - Check this box to require that the security code be entered before the 
action (command, macro, or page link) associated with this button is run.  The 
security code is set with the Edit Remote Properties command on the Edit menu. 

 

Special Functions group box 

None - Check this option to cause this button to have no special function. 

Power Down - Check this option to cause the remote to power down 
immediately when this button is pressed, instead of waiting for the timer to 
time out. 

Contrast Up - Check this option to cause this button to increase the display 
contrast when it is pressed. 

Contrast Down - Check this option to cause this button to decrease the 
display contrast when it is pressed. 

 

Pause - Enter in this box the number of seconds for the remote to pause after the 
button is released.  This value will not usually need to be changed from 0. 
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OUTPUT TAB 

                           

 

 

The options on the Output tab are: 

Output Type: 

Unless the system contains a mixture of direct IR and IRF-6/RF commands, this 
option will not normally need to be changed. 

Default - Select this option to set the default output type for this button to the 
system default.  The system default is the option selected with the Edit 
Remote Properties command on the Edit menu.   

IR - Select this option to force this button to transmit IR directly out the 
infrared window on the front of the remote, regardless of the system setting.   

RF - Select this option to force this button to transmit IR or RS-232 via RF 
through the IRF-6, regardless of the system setting.   

 

RF ID Code: 

Unless the system contains more than one IRF-6, this option will not normally 
need to be changed. 

Default - Select this option to set the default RF ID code for this button to the 
system default.  The system default is the ID code selected with the Edit 
Remote Properties command on the Edit menu.   

Code - Select this option to force this button to transmit a specific RF ID code 
when in RF mode, regardless of the system default setting.   

 

System Defaults - This section shows the global defaults for the output type and RF 
ID code, for reference.  If you wish to change these values, use the Edit Remote 
Properties command on the Edit menu. 
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IRF-6 TAB 

                           

 

The IRF-6 tab options are: 

IR Outputs group box: 

Check the box(s) that corresponds with the output(s) you wish to send the 
commands on this button out of the IRF-6.  Note that the labels for the output 
can be changed with the Edit Remote Properties command on the Edit menu. 

The default is to have the commands come out of all of the outputs on the 
IRF-6. This option will not normally need to be changed unless you have 
multiple identical components or are using one of the power sensor modules.  

 

Send this code group box: 

The options in this section require that a power sensor module be plugged into 
the appropriate port on the IRF-6.  

Always - Check this option to send the IR code regardless of the power sensor 
state.  This option should also be checked if no power sensor is connected to 
the selected IR output. 

Only when device is ON - Check this option to send the IR code only if the 
power sensor in the specified port detects that the equipment it is monitoring 
is ON. 

Only when device is OFF - Check this option to send the IR code only if the 
power sensor in the specified port detects that the equipment it is monitoring 
is OFF. 

Note: In order to use the power sensor options, exactly one IR output 
must be selected in the IRF-6 Output box, and the power sensor must be 
plugged into that IR output port. 
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INFRARED TAB 

                           

 

 

The Infrared tab options are: 

Min. Repeats - Enter in this box the number of times that the repeating part of the 
IR code is sent by the remote.  Some infrared receivers need a command to be 
repeated a certain number of times to work properly, and some may not work 
properly if the command is repeated at all. Change this setting only if you are 
having trouble with a command. 

Frequency - This box shows the carrier frequency of the IR code. This is set 
automatically. You should not need to change this value unless directed to do so 
by Technical Support. 

Sustain - Check this box to control whether or not the IR code should repeat if the 
button is held down.  Most infrared codes will transmit continuously as long as 
the button is held down, but some infrared receivers may not work properly if the 
command is repeated at all.  If the Sustain button is checked, the code will be 
transmitted for as long as the button is held down, or the Minimum Repeat times, 
whichever is greater.  If the Sustain button is not checked, the code will be 
transmitted only the Minimum Repeat number of time regardless of how long the 
button is held down. 
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RS-232 TAB      

              

 

The RS-232 function will only work if you are using the TheaterTouch in RF mode 
with an optional RTI System Interface Module, and an optional RS-232 
Communications Module. You can use up to six (6) RS-232 Communications 
Modules with any one (1) System Interface Module. (See the instructions included 
with the RS-232 Communications Module for more on installation).    

 

HOW TO SETUP RS-232 COMMUNICATIONS 
 

The RS-232 tab will appear as shown above the first time you attach an RS-232 
command to the button. Click the Create New RS-232 Code button to open the RS-
232 dialog as shown below. 
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1. Select which IRF-6 you wish to send this RS-232 command string from if 
using more than one. This is done on the Output tab of the Edit Button 
Properties dialog.  

2. Edit the communications settings (Baud Rate, Parity, etc.) to match that of the 
equipment that you are trying to control. This information should be in the 
equipment owners manual, if not contact the equipment manufacturer.  

3. Select the output port on the IRF-6 that the RS-232 Communications Module 
you want to send this RS-232 string is attached.  

4. In the String field, type in the RS-232 command string you wish to send when 
this button is pressed. The maximum number of characters is 60 in a single 
string.  

Note: If you should need more than 60 characters in a command, you can make a 
macro with two or more command strings with no time delay between them.   

 

You can type plain text into this field, and you can use the following special 
characters (called “Escape Sequences”): 

 

\a Alert / Bell (Control-G) 

\b Backspace (Control-H) 

\e Escape (Control-[) 

\f Form Feed (Control-L) 

\n Line Feed (Control-J) 

\r Carriage Return (Control-M) 

\t Tab (Control-I) 

\v Vertical Tab (Control–K) 

\\ Backslash 

\xHH Hexadecimal constant (where H is a hex digit from 0-9 or A-F) 

\dNNN Decimal constant (where N is a digit from 0-9). All three digits 
MUST be entered, so you may need to add leading zeros. 

 

Note: Because the backslash {\} character is used to introduce each Escape Sequence, 
you MUST use the \\ form to enter a backslash character, if one is needed by your 
string. 
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COMMAND TAB 

                           

 

 

The Command tab displays the manufacturers name, type of equipment, model 
number and function of the command on a button. 

 

 

 

WAVEFORM TAB 

 

                               

 

 

The Waveform tab displays the waveform of a command for advanced 
troubleshooting or if you would just like to see what Infrared data looks like. 
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HOW TO EDIT THE PROPERTIES OF MULTIPLE BUTTONS 

 
The Edit Button Properties dialog allows you to edit many different attributes of a 
button or a group of buttons. 

To edit the properties of multiple buttons at once:  

1. Select the buttons using the Select Button tool  from the Tool Palette. 

2. Click the right mouse button on one of the selected buttons, either 
touchscreen or keypad buttons and choose Edit Properties.  

For an explanation of all the button properties, see the “How to Edit Button 
Properties” section.   

  

Note: Not all of the tabs and/or controls will be available simultaneously.  Only the 
options relevant to the button(s) being edited will be shown. 

 

 

A note about Multiple Selections  

If you have more than one button selected, it is possible that they will initially 
have different settings.  

The following meanings apply to options with a check box: 

 All buttons in the selection will retain their original values for the setting. 

 All buttons in the selection will have the setting set to TRUE 

 All buttons in the selection will have the setting set to FALSE 

 

If options with numerical fields have different values, they will be left blank.  
If you DO NOT enter a number, all the buttons will retain their original 
setting.  If you DO enter a number, all the buttons will be set to that value. 

 

If options with radio buttons have different settings, NONE of the radio 
buttons will have a dot next to them. In that case, each button will retain its 
original function.  If you do wish to assign the SAME function to EVERY 
button, select one of the functions from the dialog. 
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HOW TO PRINT SCREENSHOTS 
 

TheaterTouch Designer comes with the ability to print screenshots of the individual 
frames of your remote file for reference purposes.  

To print screenshots of the open remote file: 

1. Choose Print from the File menu. 

2. Choose whether you want to 

a) Print Current Page Only – Prints a life-sized image of all of the frames 
of the currently displayed page. 

b) Print All Pages on One Sheet – Prints all of the frames from all of the 
pages in the current file on a single sheet of paper, scaling them if 
necessary. 

c) Print All Pages, 1 Per Sheet – Prints life-sized images of all of the 
pages in the current file, with all of the frames from each page 
grouped together on individual sheets of paper. 

3. Click OK. 

 

 

 

HOW TO PRINT SYSTEM CONFIGURATION REPORTS 
 

TheaterTouch Designer comes with the ability to create System Configuration Reports. 
This report is for archival purposes as well as a visual reference guide of the system 
options and each IRF-6 configuration.    

To print the Configuration Report of the open remote file: 

1. Choose System Configuration Report from the File menu. 

2. Click the Print command button. 

3. Click OK to close. 

 

To copy the Configuration Report of the open remote file to the Windows clipboard:  

1. Choose System Configuration Report from the File menu. 

2. Click the Copy command button. 

3. The System Configuration Report is now on the Windows clipboard. 

4. Click OK to close. 
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HOW TO CHECK MEMORY USAGE 
 

It is possible, though not likely, to create a file in TheaterTouch Designer with more 
information than the TheaterTouch can hold.  To make sure this does not happen, use 
the Check Memory Usage command on the Edit menu to see how large the current 
file is.   

The Remote Memory Used dialog displays the amount of space that buttons, 
bitmaps, custom buttons, commands, and macros take up in the TheaterTouch system 
controller’s 128KB of memory.  The pie chart in the dialog represents the amount of 
memory that each of the object types uses. 

If the memory is more than 100% full, the Free line will show a negative amount of 
memory, and will be flashing red.  In this case, the following warning will be 
displayed in the dialog box: 

 

  

 

You will have to delete enough objects so that the Free line is not flashing red before 
you can send this file to the TheaterTouch. 
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HOW TO CREATE A “SELF-DOWNLOADING .EXE” 
 

This command creates an executable from the current file that will automatically 
download itself to the remote when run.  These executables can be distributed to 
client sites to simplify the process of updating remotes in the field.  

TheaterTouch Designer does not need to be installed for the self-contained executable 
to work. 

 

To make a Self-Downloading .EXE of the current file: 

1. Choose Create Self-Downloading .EXE from the Communications menu. 

2. Choose the location you want to save the file in the Save in address box. 

3. Enter the name of the file in the File Name box. 

4. Click the Save button to save and close. 

You can now put the .EXE file on a diskette or E-Mail it. 

 

 

HOW TO USE THE “SEND” COMMAND 
 

This command sends the current file through electronic mail.  This command is only 
available if your computer has a properly configured e-mail client that is compatible 
with the Microsoft MAPI specification. Microsoft Exchange and Microsoft Outlook 
are two examples of MAPI-compliant e-mail clients. 

TheaterTouch Designer does need to be installed for the file to work. 

 

To send the current file via E-Mail: 

1. Choose Send from the File menu. 

2. The default E-Mail program will open with the current file inserted as an 
attachment with the extension .rti. 

3. Send the E-Mail as required by you E-Mail program.  
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Chapter 6. IR Library Manager 

The TheaterTouch reproduces the infrared commands of other remote controls. Each 
of these infrared commands must be captured (learned) and placed into the 
TheaterTouch Designer Command Library.  

This is done by using the original remote control (the donor) from a piece of 
equipment to teach its commands to the TheaterTouch. The TheaterTouch then transfers 
the captured command to the Infrared Library Manager software through its RS-232 
serial port. Once a command is placed in the infrared library, it never has to be 
captured again. 

Before you can send infrared commands to the PC, you need to create a new remote 
file by going to the IR Library Manager in the TheaterTouch Designer software. 

 

INFRARED CODES  
There are two types of infrared codes that are commonly used for consumer 
electronics products: Frequency Modulated and Pulsed. 

 

 

FREQUENCY MODULATED 

This type of transmission modulates the IR energy at a fixed carrier frequency. The 
vast majority of consumer electronics remote controls use a carrier frequency around 
40kHz, although the carrier can range from 15kHz to 455kHz or higher. The 
TheaterTouch is designed to reproduce carrier frequencies between 15kHz and 460kHz. 

The actual code consists of bursts of IR energy modulated at the carrier frequency, 
separated by pauses. 

                        

Pause40 kHz Burst

 

 

The code is defined by the length of each burst and each pause, as well as by the 
carrier frequency. 
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PULSED IR CODES 

This type of transmission does not use a carrier frequency. 

 

                        

Pulsed codes are common in cable TV converter boxes. 

 

 

HOW THE THEATERTOUCH LEARNS IR CODES 
 

There are many different encoding schemes used for IR codes. The burst and pause 
times have fixed lengths, variable lengths, or some combination of the two. To learn 
the code, the TheaterTouch  “records” a sample of the code in a manner similar to the 
way a tape recorder records sound. Once a sample of the code has been taken, it is 
analyzed to find any repeating patterns. 

Some codes continuously repeat themselves for as long as the button is pressed. 
Others send a code followed by a “keep alive” pattern. Some codes don’t repeat at all. 
Any of the above types of codes can also have some sort of preamble in front of them. 
It is very important to capture the preamble in this type of code. The IR learning 
buffer of the TheaterTouch is large enough to accommodate the preamble. 

When a repeating pattern is found, extra repeats are stripped off before the code is 
stored in memory. The number of repeats is also stored so the code can be 
reproduced accurately. 

If the buffer was filled up during learning, it is assumed that the pattern should be 
repeated for as long as the key is pressed. This is common for commands such as 
Volume, Balance, and Scan— functions that may need to be continuously repeated. 
For these types of commands, Sustain is set ON as the Edit IR default. If the buffer is 
not filled, Sustain is set OFF and the repeat pattern is displayed as the Minimum 
Repeats.  

The default Minimum Repeats for a code with Sustain ON is one. This means the 
repeating pattern will repeat at least one time when the button is pressed. You can 
edit this if necessary, in the Edit IR mode of Infrared Library Manager software. 

If the code uses a carrier frequency, that frequency is also stored with the code. 
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HINTS FOR LEARNING IR CODES 
 

Always place the TheaterTouch and the donor remote control on a flat surface. You 
may find it necessary to elevate the donor or the TheaterTouch with a book or similar 
object to align them vertically.  

Once you have learned and tested a code from a remote, try not to move it until you 
have learned all the codes. If you do accidentally move either remote, you should re-
align them. 

It is VERY IMPORTANT to make sure the donor remote is using fresh batteries. The 
TheaterTouch needs a strong IR signal to properly learn a code.  

If the frequency read-out in the ALIGN mode is 0.0 kHz, then the code is a pulsed 
type. In this case, you should transmit the commands to the TheaterTouch from the 
longest distance you can without getting an error message. 

If you always get an error message when trying to learn a code, you should try 
moving the donor remote up and down or back and forth. If this does not help, try 
tapping the buttons on the donor instead of holding them down. 

Many commands can be made more reliable if the number of repeat times is 
increased. This is especially true for commands assigned to buttons that are likely to 
be briefly “tapped” or for commands that are part of a macro.  

Increasing the number of repeat times increases the probability of the command 
“getting through.” This is essentially a trade-off between increased reliability and an 
increase in the length of time required to transmit a command. This can take a bit of 
fine-tuning on complicated macros. 

Keep in mind that the IR transmit LEDs may not be located in the center of the donor 
remote. It may be necessary to place the remote off-center to get a reliable capture. 
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HOW TO OPEN THE IR LIBRARY MANAGER 
 

1. Choose IR Library Manager from the Library menu from the TheaterTouch 
Designer toolbar. 

2. From here, you can decide to create a new library of commands or add to 
an existing library by choosing from the File menu either New or Open. 

 

 

HOW TO CREATE A NEW IR LIBRARY  
 

 

1. Choose New from the File menu, the Create IR Library dialog box will 
open.  

2. Enter the name of the new library in the File name box.  

3. Be sure to save your new file in the Command Libraries folder of the 
TheaterTouch Designer software folder. 

4. Click the Save button to create the library. 
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Once you click the Save button, the Edit View dialog box will open showing you the 
remotes that are in that particular library. If there are no remotes in that library, such 
as after creating a new library, the fields will be empty.    
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HOW TO OPEN AN EXISTING IR LIBRARY 
 

1. Choose Open from the File menu. 

2. When the Open IR Library dialog box opens, select the file you wish to 
open.  

3. Click the Open button. 

                           

                          
 

Once you click the Open button, the Edit View dialog box will open showing you the 
remotes that are in that particular library. 
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HOW TO ADD A NEW REMOTE TO AN IR LIBRARY 
 

1. Click on the New button on the upper right hand side of the Edit View 
dialog box.  

2. This will open the Create New Remote dialog box.  

                                  

 

 

3. Enter the manufacturer’s name, type of equipment, (such as TV, VCR, 
Drapes, Lights and so on) and model number of the component or remote 
in the appropriate fields. 

4. In the function field, enter the name of the actual commands you are 
going to learn (such as Channel+, Channel-, Volume+, Volume-, Power, 1, 
2, 3 and so on). 

5. After you enter each function name click on the Add command button to 
save, you can always edit the name of a function later if you make a 
mistake or add a function. 

6. Repeat steps 4 and 5 for each button on the remote. 

7. When done entering information about new remote, click on the OK 
command button to save and close.  
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HOW TO USE THE NEW REMOTE WIZARD 
 

If you are entering a commonly used component to the IR Library, you can use the 
New Remote Wizard to enter the titles of commonly use commands for that type of 
equipment. 

1. Open the Create New Remote dialog box. 

2. Enter the information on the equipment you are about to learn commands 
from.  The manufacturers name, type of equipment, (such as TV, VCR, 
Drapes, Lights and so on) and model number of the component or remote 
in the appropriate fields. 

3. Click the Wizard command button; this will open the New Remote 
Wizard dialog box. 

4. Check or uncheck the function titles you wish to insert and click OK. 

5. You can always edit the name of a function later if you make a mistake or 
add a function. 

6. When done entering information about new remote, click on the OK 
command button to save and close. 
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HOW TO ALIGN A DONOR REMOTE CONTROL 
 

To ensure that a valid signal is being received, all donor remote controls must be 
properly aligned with the TheaterTouch learning window. This is the window located 
on the front of the unit. 

 

The TheaterTouch has an ALIGN function to help determine the correct position in 
front of the learning window, and determine the modulation frequency of the donor 
remote’s infrared signal. This function is invoked upon entering the IR CAPTURE 
mode from the CONTROL PANEL page. 

 

 

                                     

 

IMPORTANT: The Align function determines the modulation frequency of the 
donor remote’s infrared signal; so all donor remote controls must be aligned 
before being captured. 
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To properly align a donor remote control with the TheaterTouch:  

 

1. Make sure the donor remote has fresh batteries then line up donor remote 
so that is at the same height as the learning window on the TheaterTouch. It 
may be necessary to place the donor remote control on a higher surface 
than the TheaterTouch, or vice-versa.   

2. Press any key on the donor remote control, moving the remote back and 
forth in front of the learning window. The donor remote control is located 
at the proper distance from the TheaterTouch when the Signal box is on 
(darkened) and the frequency read-out is stable. The frequency readout 
should not be 0.0kHz if it is possible to get it to read any other number by 
moving the donor remote around. If the Signal box is off (white), the 
TheaterTouch is not detecting any infrared signal. 

3. If the Overload box is darkened, the donor remote is too close to the 
TheaterTouch. Move the donor remote away from the TheaterTouch until 
the Overload indicator turns white. 

 

 

 

    

Learning Window

Approximately
2-4"
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HOW TO CAPTURE INFRARED COMMANDS 
 

Once a donor remote control is properly aligned, the TheaterTouch is ready to start 
capturing the IR commands and transferring them to the Infrared Library Manager 
Software.  

1. Make sure the TheaterTouch is in the IR CAPTURE LEARN MODE on 
frame 2 of the IR CAPTURE page and says STATUS: READY.  

The last frequency measured with the ALIGN function should be 
displayed at the bottom of the screen. If it is not, you must go through the 
Align Procedure again. 

 

                                    

 

2. The communications cable should be connected to the TheaterTouch and 
the PC. The TheaterTouch Designer software needs to be running with the 
Infrared Library Manager window open.  

The dialog box should say Edit View on the title bar with the name of the 
infrared library you are working in after it.  

3. Click on the Learn IR command button and if you are still properly 
aligned, you are ready to start capturing codes.  
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4. Now press and hold the key on the donor remote control that transmits 
the command that you want the TheaterTouch to learn. Continue to hold 
the key down until the TheaterTouch displays OK. 

After the command has been processed, the TheaterTouch will display 
Captured then Sending. If an error message is displayed, realign the 
donor remote control and try again.  

If the IR command was captured properly, it will be stored in a temporary 
memory buffer, and transferred to the Infrared Library Manager software 
automatically. A red dot will be placed in front of the function text to let 
you know that the function has been learned. 

The command will remain in memory (for testing) until it is overwritten 
by the next captured command. The software will prompt you for each 
function command to be learned.  

5. To close the IR Capture window in the software click on the Close button. 

6. To close the IR Capture page on the remote, press the Main Menu button 
on the keypad. The remote will stay in the IR Capture mode until you 
manually press the Main Menu button. 
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HOW TO TEST INFRARED COMMANDS 
 

After the TheaterTouch has learned a command, you can test it to make sure it behaves 
properly. 

1. Press the SELECT button while in the IR Capture Test Mode on frame 3 of 
IR Capture page, this will test the last captured IR command. 

The command will remain in memory (for testing) until it is overwritten 
by the next captured command.  

2. Make sure you point the TheaterTouch at the equipment to be controlled 
when you press the SELECT button. 

 

 

                   
 

 

If the command does not work properly, it may need to be edited or re-
learned.  

3. To close the IR Capture window on the remote press the Main Menu 
button. 

SELECT Button 
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HOW TO EDIT INFRARED COMMANDS 
 

Most infrared commands will transmit continuously as long as the remote control 
key is held down. This means that either the entire command or some part of it is 
being repeated over and over. 

The Infrared Library Manager software allows you to adjust the number of command 
repeat times and to enable or disable continuous transmission.  

                           

 

Min. Repeats - Enter in this box the number of times that the repeating part of the IR 
code is sent by the remote.  Some infrared receivers need a command to be repeated a 
certain number of times to work properly, and some may not work properly if the 
command is repeated at all. Change this setting only if you are having trouble with a 
command. 

Frequency - This box shows the carrier frequency of the IR code. This is set 
automatically. You should not need to change this value unless directed to do so by 
Technical Support. 
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Sustain - Check this box to control whether or not the IR code should repeat if the 
button is held down.  Most infrared codes will transmit continuously as long as the 
button is held down, but some infrared receivers may not work properly if the 
command is repeated at all.  If the Sustain button is checked, the code will be 
transmitted for as long as the button is held down, or the Minimum Repeat times, 
whichever is greater.  If the Sustain button is not checked, the code will be 
transmitted only the Minimum Repeat number of time regardless of how long the 
button is held down. 

Apply – Use this to save any changes you have made. 

Test – Use this to test any changes you have made to a command. Make sure to have 
the TheaterTouch hooked up to the computer with the serial cable and have the 
remote in Test IR Mode on frame 3 of the IR Capture page in the Control Panel.  
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Chapter 7. Image Editors 

The TheaterTouch Designer software comes with two additional programs for creating 
custom graphics. These programs are very similar in appearance and functionality 
and both programs can be accessed from the Library menu within the TheaterTouch 
Designer program. 

The Button Bitmap Editor is for creating and editing button bitmaps for such things 
as channel and transport icons. 

The Custom Button Editor is for creating and editing custom buttons for such things 
as company logos or complex groups of controls.  

 

THE DIFFERENCE BETWEEN CUSTOM BUTTONS AND BITMAPS 
 

Custom Buttons have several fundamental differences from Bitmaps: 

1. Custom Buttons must specify an image of the entire button.  Bitmaps are 
smaller, and therefore can be placed on buttons with the standard border 
styles. 

2. Custom Buttons can contain more than one active button area, so a whole 
group of related controls can be created as a single Custom Button. 
Bitmaps are indivisible, and must be placed separately onto individual 
buttons. 

3. Custom Buttons must provide an image for both the Up (normal) and 
Down (pressed) states of the button.  Bitmaps provide only the Up image.  
The Down image of a Bitmap is created by simply inverting it. 

4. Custom Buttons can be any size, up to the entire display size.  Bitmaps are 
limited to a handful of pre-defined sizes. 

 

Given these characteristics, Custom Buttons are most appropriate for complex or 
large groups of controls, such as a customized set of transport controls for a VCR, or a 
large company logo.   

Bitmaps are most appropriate for small pictures that don’t need a full button to 
display, such as TV channel icons or small logos.  Since Bitmaps don’t have a Down 
image, they take half as much memory to store in the TheaterTouch, so more Bitmaps 
can be created. 

Both Custom Buttons and Bitmaps are stored within Libraries, not as individual files.  
Before you can design your own Custom Buttons or Bitmaps, you must create a new 
library file using the Custom Button Editor or Button Bitmap Editor.  The library file 
can have many Custom Buttons or Bitmaps within it.  
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BUTTON BITMAP EDITOR SCREEN 
 

To open the Button Bitmap Editor, select Button Bitmap Editor from the Library 
menu in the TheaterTouch Designer program. 
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CUSTOM BUTTON EDITOR SCREEN 
 

To open the Custom Button Editor, select Custom Button Editor from the Library 
menu in the TheaterTouch Designer program. 
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TOOLBAR 
 

The toolbar provides instant access to commonly used Button Bitmap Editor and 
Custom Button Editor functions.  

 

 

 Create New Library Command – Use this command to create a library to hold your
 custom buttons or bitmaps. The built in libraries that come with the software are 
 read-only and new images cannot be saved to them. This command should only be 
 used when a new library is desired. If you want to create a new image, use the Create
 New Image Command. 

 Open Library Command – Use this command to open existing libraries. The 
 currently open library, if any, will be closed. 

 Edit Library Command – Use this command to rename or delete a custom button or 
bitmap in a library that you created. The built in libraries that come with the software 
are read-only and images cannot be edited. This command is not available unless a 
Bitmap Library is open.  

 Create New Image Command – Use this command to create a new image in the
 currently open library in the Bitmap Editor, the New Bitmap Size dialog will be 
 displayed, where you can select the size for the new Bitmap. The built in libraries that 
 come with the software are read-only and new images cannot be saved to them. 

 Open Image Command – Use this command to open an existing image in the 
currently open library for editing. When you choose the Open Image command, the 
Open Image dialog box is displayed to allow you to select which image to edit. This 
command is not available unless a Bitmap Library is open. 

 Save Image Command – Use this command to save the current image to the 
currently open library.  If the image has already been saved, this command updates 
the existing version.  If the image has never been saved before, this command is the 
same as the Image Save Image As command, and displays the Edit Title dialog for 
you to enter a name.  This command is not available unless a library is open and an 
image is being edited. 
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 Undo Command – Use this command to reverse the last change you made to the 
image.  Choose the Undo command again to reverse the previous change.  A 
maximum of 64 changes are reversible with the Undo command.  The Undo 
command can only reverse editing changes to the current image.  It cannot undo 
changes to a library, and the Undo information is destroyed when the image is closed 
or the view is toggled between the Up and Down images in the Custom Button Editor.
  

 Redo Command – Use this command to cancel the effect of the last Undo command.  
Choose the Redo command again to cancel the next Undo.  A maximum of 64 
changes can be canceled with the Redo command.  The Redo command can only 
cancel Undo commands to the current image.  The Redo information is destroyed 
when the image is closed, when the view is toggled between the Up and Down 
images, or when other editing changes are made to the image. 

  

 Cut Command – Use this command to move the selected sections to the Clipboard, 
this replaces the selection with solid white. You can use this to move images between 
the Button Bitmap Editor and the Custom Button Editor. 

  

 Copy Command – Use this command to copy selected sections to the Clipboard. This 
command does not alter the current image. You can use this to move images between 
the Button Bitmap Editor and the Custom Button Editor.    

  

  Paste Command – Use this command to place previously cut or copied sections from 
the clipboard back onto the touchscreen grid and switches the Button Bitmap Editor 
or Custom Button Editor into Selection mode. You can drag the pasted sections to 
the desired position on the page. You can use this to move images between the 
Button Bitmap Editor and the Custom Button Editor. This command is not available 
if the data on the Clipboard is not in bitmap format. 

  Help Topics – Use this command to open the Help Topics dialog box for more help. 
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TOOL PALETTE 
 

The Tool Palette provides access to all the drawing tools used by the Button Bitmap 
Editor and Custom Button Editor. 

   

 

 Selection Tool - The Selection Tool is used to define a rectangular selection region 
on the image.  To define a selection, click the left mouse button in the Drawing Area 
where one corner of the selection rectangle should be placed, drag the mouse to the 
opposite corner, and release the mouse button. 

 Button Selection Tool (Custom Button Editor only) - The Button Selection Tool 
defines the active button areas on a Custom Button image. To define a button 
selection, click the left mouse button in the Drawing Area where one corner of the 
selection rectangle should be placed, drag the mouse to the opposite corner, and 
release the mouse button.  To remove an existing button selection, place the mouse 
cursor inside of the selection you wish to remove and click the right mouse button. 

 Zoom Tool - The Zoom Tool is used to magnify portions of the image.  Click the left 
mouse button over a spot in the Drawing Area to “Zoom In” (make the image larger) 
or click the right mouse button over a point to “Zoom Out” (make the image smaller).  
The Zoom commands on the View menu can also be used to change the Zoom level. 

 Pencil Tool - The Pencil Tool is used to color individual pixels on the image.  Click 
the left mouse button in the Drawing Area to turn the pixel under the Pencil point 
black, and click the right mouse button to turn the pixel white. 

 Brush Tool - The Brush Tool acts like the Pencil Tool, but colors a larger portion of 
the image.  The Brush Size, the size of the shape that the Brush draws, can be 
changed by clicking on a different sized brush in the rectangular area below the 
drawing tools, or by choosing a size from the Brush Size menu under the View menu.  
Click the left mouse button in the Drawing Area to turn the pixels under the Brush 
black, and click the right mouse button to turn the pixels white. 
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 Fill Tool - The Fill Tool is used to color large portions of the image.  Several Fill 
Patterns are available in the rectangular area below the drawing tools.  To use the Fill 
Tool, choose the desired Fill Pattern, and then click the left mouse button inside of 
the area to fill.  The Fill Tool will color the image with the Fill Pattern in all directions 
until it encounters a black line or the edge of the image.  If the fill is to be contained to 
the inside of a shape, be sure that there are no gaps in the shape’s border. 

 Eraser Tool - The Eraser Tool is identical to the Brush Tool except that clicking the 
left mouse button draws in white, and clicking the right mouse button draws in 
black. 

 Line Tool - The Line Tool is used to draw straight lines on the image.  To draw a 
black line, click and hold the left mouse button in the Drawing Area where one end 
of the line should go, move the mouse to the other end of the line, and release the 
mouse button. To draw a white line, follow the same steps but click the right mouse 
button instead of the left. 

 Text Tool - The Text Tool is used to place text on the image.  To place text, click the 
left mouse button in the Drawing Area, and the Place Text dialog will appear.  Enter 
the desired text in the dialog and click OK.  The text will appear in a blue selection 
rectangle, where it can be placed precisely on the image. 

 Rectangle Tool - The Rectangle Tool is used to draw rectangles on the image.  Click 
the left mouse button in the Drawing Area where one corner of the rectangle should 
be placed, drag the mouse to the opposite corner, and release the mouse button.  To 
draw a white rectangle, follow the same steps but click the right mouse button 
instead of the left.  The portions of the image in the center of the rectangle are not 
affected by this tool. 

 Rounded Rectangle Tool - The Rounded Rectangle Tool is used to draw rectangles 
with rounded corners on the image.  The radius of the corners is the same as that of 
“Radius” buttons on the TheaterTouch.  Click the left mouse button in the Drawing 
Area where one corner of the rounded rectangle should be placed, drag the mouse to 
the opposite corner, and release the mouse button.  To draw a white rounded 
rectangle, follow the same steps but click the right mouse button instead of the left. 
The portions of the image in the center of the rounded rectangle are not affected by 
this tool. 

 Circle Tool - The Circle Tool is used to draw circles and ovals on the image.  Click 
the left mouse button in the Drawing Area where one corner of the imaginary 
rectangle that bounds the circle should be placed, drag the mouse to the opposite 
corner, and release the mouse button.  To draw a white circle, follow the same steps 
but click the right mouse button instead of the left. The portions of the image in the 
center of the circle are not affected by this tool. 
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 Filled Rectangle Tool - The Filled Rectangle Tool is used to draw rectangles filled 
with a Fill Pattern on the image. Several Fill Patterns are available in the rectangular 
area below the drawing tools.  To use the Filled Rectangle Tool, choose the desired 
Fill Pattern, click the left mouse button in the Drawing Area where one corner of the 
rectangle should be placed, drag the mouse to the opposite corner, and release the 
mouse button.  To draw a solid white rectangle, follow the same steps but click the 
right mouse button instead of the left. 

 Filled Rounded Rectangle Tool - The Filled Rounded Rectangle Tool is used to 
draw rectangles with rounded corners filled with a Fill Pattern on the image. Several 
Fill Patterns are available in the rectangular area below the drawing tools.  To use the 
Filled Rounded Rectangle Tool, choose the desired Fill Pattern, click the left mouse 
button in the Drawing Area where one corner of the rectangle should be placed, drag 
the mouse to the opposite corner, and release the mouse button.  To draw a solid 
white rounded rectangle, follow the same steps but click the right mouse button 
instead of the left. 

 Filled Circle Tool - The Filled Circle Tool is used to draw circles and ovals filled 
with a Fill Pattern on the image. Several Fill Patterns are available in the rectangular 
area below the drawing tools.  To use the Filled Circle Tool, choose the desired Fill 
Pattern, click the left mouse button in the Drawing Area where one corner of the 
imaginary rectangle bounding the circle should be placed, drag the mouse to the 
opposite corner, and release the mouse button.  To draw a solid white circle, follow 
the same steps but click the right mouse button instead of the left. 

 

 

UP IMAGE-DOWN IMAGE TOOL (Custom Button Editor Only): 

   

  

Click on the Up Image button to display the Up Image in the Drawing Area, or click 
on the Down Image button to display the Down Image. 

All Custom Buttons have two totally separate images, an Up image, which represents 
the button in its normal state; and a Down image, which represents the button in its 
pressed state.  The Up image is the picture that is normally displayed by the 
TheaterTouch, unless the button has its Reversed property set, in which case the 
Down image is normally displayed. 
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In most cases, you will find it easiest to create the Up image first.  As a starting point 
for creating the Down image, you may want to select the whole Up image, copy it to 
the Clipboard, switch to the Down image, and paste the image from the Clipboard.   

At this point, you can use the editor to modify the image you pasted to make it the 
Down image.  If a simple reversal is all you need, the Invert Selection command on 
the Edit menu will do the trick. 

 

 

 

NEW BITMAP SIZE DIALOG BOX (Button Bitmap Editor Only): 
 

The New Bitmap Size dialog box opens when you select the Create New Image 
command. You can choose from the five sizes listed in the dialog box, a sample of the 
size will be displayed in the Sample section. 

 

 

26 by 10 pixels = 1 section wide by 1 section high, which is the smallest button 
bitmap size. 

26 by 26 pixels = 1 section wide by 2 sections high, which is the standard channel 
icon size. 

58 by 26 pixels = 2 sections wide by 2 sections high, which is one-third of the 
touchscreen 

58 by 42 pixels = 2 sections wide by 3 sections high, which is half of the touchscreen. 

58 by 58 pixels = 2 sections wide by 4 sections high, which is two-thirds of the 
touchscreen. 
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Chapter 8. Troubleshooting 

If you have difficulty with your TheaterTouch universal system controller, read 
through these troubleshooting tips and common questions before contacting 
technical support. 

If you continue to have difficulties, do not hesitate to contact technical support. See 
chapter 9 for more information on contacting RTI. 

 

DISPLAY IS DIM, BLANK OR UNREADABLE 
 

Make sure the battery pack is snapped on the remote properly and that the battery is 
charged. 

Try adjusting the contrast of the touchscreen on the Control Panel page of the 
remote. By nature, the contrast of an LCD screen changes with temperature, so if the 
remote is cold the display will be dark and will lighten as it warms. (Refer to Chapter 
2 for more details) 

The remote may have timed out, turning off the display. You can change the Time 
Out time on the Control Panel page of the remote to your liking. (Default time is 10 
seconds) (Refer to Chapter 2 for more details) 

 

COMMUNICATION PROBLEMS 
 

Make sure the Computer Link button on frame 3 of the Control Panel page of the 
TheaterTouch is pressed before beginning the communication operation. 

 

Make sure you are using the programming cable that was supplied with the unit and 
that both ends are connected securely. 

 

If the only serial port on your computer has a serial mouse plugged into it, you can 
disconnect the mouse and use that port with the TheaterTouch Designer software. If 
you do this, you MUST restart Windows with the mouse unplugged before 
TheaterTouch Designer will be able to use the port. 

 

If the serial port you are trying to use is COM 3 or COM 4, make sure that it is not 
sharing an interrupt request (IRQ) line with COM 1 or COM 2. The default 
configuration for COM 1 and COM 3 both share IRQ 4, and COM 2 and COM 4 both 
share IRQ 3. Contact your computer manufacturer for more information on 
configuring your serial ports. 
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If you are trying to use the second serial port on your computer, it is possible that it is 
disabled in the computer’s CMOS (or BIOS) setup. Consult your computer’s 
documentation or contact your computer manufacturer for more details. 

 

If your computer is a notebook or laptop, be sure that the external serial port is 
enabled properly. Some laptops, especially (but certainly not limited to) IBM 
ThinkPads, have their external ports disabled by default.  

• If your computer has an IrDA infrared port, there may be a setting where you 
can choose between the infrared port and the serial port. 

• Some portable computers with Advanced Power Management disable the 
external serial ports to conserve battery power. 

• Some with PCMCIA card sockets reserve the COM 2 connector for use with a 
PCMCIA card.  

• You may need to run your computer’s setup or configuration program to 
enable the port. Consult your computer’s documentation or contact your 
computer manufacturer for more details. 

  

Make sure no other software running on your computer is trying to access the serial 
port. If you have a PDA (such as a 3COM Palm Pilot or Apple Newton), scanner 
(such as a Visioneer PaperPort), graphics tablet, fax modem or other serial devices 
that plug into the same serial port, you need to disable its software and restart 
Windows before TheaterTouch Designer can use that serial port. 

 

If you have an internal modem and an external COM port at the same address, the 
external COM port will not work and must be reconfigured. For example, if the 
internal modem is set to use COM 2, the computer’s built in COM 2 port will not 
function correctly.  

 

Use the Auto Detect option in the Communication Setup dialog box. Use the Set 
COM Port command on the Options menu to display the Communication Setup 
dialog box and then click the Auto Detect command button to determine which serial 
port the remote is connected to. The serial port on your computer may be mislabeled. 

 

If you are communicating with the TheaterTouch and the transfer fails after some data 
has been transferred, your computer may not support TheaterTouch Designer’s high-
speed communication protocol. Use the Set COM Port command on the Options 
menu to display the Communication Setup dialog box and select the “Medium” or 
“Low” communication speed.  
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INFRARED PROBLEMS 
 

The TheaterTouch and TheaterTouch Designer software are compatible with infrared 
(IR) commands with carrier frequencies between 15kHz and 460kHz. This covers the 
vast majority of remotes available to date, including Bang & Olufsen® (most of which 
use 455kHz) and Vidikron® (some of which use 333kHz). 

 

However, some older Pioneer® Elite remotes have a carrier frequency of 1.125MHz 
and are not compatible with most IR products, including the TheaterTouch and 
TheaterTouch Designer software. You can however use IR commands from regular 
(non-Elite) Pioneer® remotes, which have a carrier frequency of 40kHz. These regular 
Pioneer® IR commands operate the basic functions of the Elite products.   

 

When learning IR commands, use fresh batteries in the donor remote. Even if the 
donor remote still operates the equipment, using fresh batteries will ensure good, 
strong, clean signals. 

• Keep ambient light to a minimum. Avoid bright overhead lighting such as 
fluorescent and neon lighting or direct sunlight. 

• Make sure the donor remote is positioned properly. The TheaterTouch has 
a signal level display that indicates when the donor remote is too close or 
too far away from the learning window. Just the Signal box should light 
(go dark) when you have the proper level.  

• Once you have proper alignment, do not move either the TheaterTouch or 
the donor remote until done learning all the commands you wish to learn.  

• Because every remote is different, you must go through the alignment 
procedure every time you learn any new commands to insure the best 
possible range and consistency of each IR command. 

 

If a learned command is not working properly, try relearning the command making 
sure to go through the entire alignment procedure. 

 

If you are using an IR repeater system, make sure it is working flawlessly with the 
donor remote, if not you need to fix or repair the IR system. The TheaterTouch remote 
even with its advanced features cannot overcome these kinds of problems.  

 

If you are still having problems, try using the Edit IR function in the Infrared 
Library Manager to adjust the frequency up or down in small steps you should retest 
the command after each change. This can be done by clicking on the Test command 
button on the bottom of this page. 
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UNABLE TO LEARN COMMANDS 
 

If for some reason you are unable to learn commands into the TheaterTouch, or you 
cannot get commands to work, contact Technical Support to see if we can help you.  

You may wish to check our web site to see if the codes are already available. 

If need be we can try to learn the commands for you at our factory by sending us the 
donor remote. 

If successful, we can send you the commands via E-Mail or on diskette so you can 
insert them into your remote file. It will also be posted on our web site for others to 
use. 

 

 

MACRO PROBLEMS 
 

If you are having problems with missed commands in macros but the IR commands 
work fine when placed on individual buttons try editing the Minimum Repeats in 
the Macro Editor to increase the number of times the command is repeated. 

 

Click on the Edit Macro tool from the Tools dialog box on the bottom of the main 
screen, click on the button on which the macro you are having trouble with is. When 
the Edit Macro dialog box opens, double-click on the specific IR command you are 
having the trouble with, when the Edit Infrared Command dialog box opens, change 
the number of repeats to 4 or 5 to start with and if that doesn’t work, bump it up to 7 
or 8. 

 

As always, when you make any changes to your file, be sure to send the new file to 
the remote and thoroughly test your changes.   

 

Minimum Repeats is usually set between 0 and 3, but some commands may need to 
be repeated more times. You can set the number of repeats as high as you need to get 
consistent results. 
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Chapter 9. Service and Support 

UPDATES AND NEW PRODUCTS 
 

For news about the latest updates, new product information and accessories, please 
visit our web site at:  

www.TheaterTouch.com 

 

CONTACTING REMOTE TECHNOLOGIES INCORPORATED 
 

For general info, you can contact RTI at:  

Info@rticorp.com  

  

Remote Technologies Incorporated 

Tel. (612) 253-3100 

Fax (612) 253-3131 

www.rticorp.com 

 

RTI TECHNICAL SUPPORT 
 

At RTI, customer service and satisfaction is an utmost priority. If you are 
encountering any problems or have a question about your RTI product, please 
contact RTI Technical Support for assistance.  

RTI provides technical support by telephone, fax or E-mail. For the highest quality 
service, please have the following information ready, or provide it in your fax or E-
mail.  

 

♦ Your Name 

♦ Company Name 

♦ Telephone Number 

♦ E-mail Address 

♦ Product model and serial number (if applicable) 

http://www.theatertouch.com
mailto:info@rticorp.com
http://www.rticorp.com
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If you are having a problem with hardware-note the equipment you are using, what 
the problem is you are having and any troubleshooting you have tried. 

If you are having a problem with software-note what version software you are using, 
the operating system on your PC, what the problem is you are having and any 
troubleshooting you have tried. 

If you are calling in regards to a software or programming question or problem, 
please be at you computer when you place your call, this will considerably speed up 
the troubleshooting process.  

 

For technical support or assistance with your TheaterTouch remote, software or 
accessories, contact RTI at: 

(612) 253-3137 

support@rticorp.com 

www.rticorp.com/support 

 

For questions regarding service or repair of your TheaterTouch remote control, contact 
RTI at: 

(612) 253-3136 

service@rticorp.com 

www.rticorp.com/service 

 

Please do not return products to Remote Technologies Incorporated without return 
authorization. 

mailto:support@rticorp.com
http://www.rticorp.com/support
mailto:service@rticorp.com
http://www.rticorp.com/service
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SHIPMENT OF REMOTE FOR SERVICE 
 

Remote Technologies Incorporated will pay all labor and material expenses for all 
repairs covered by this warranty. If necessary repairs are not covered by warranty, or 
if a unit is examined which is not in need of repair, you will be charged for the 
repairs or examination. 

 

If it is necessary to ship the TheaterTouch system controller for service:   

Please pack it securely and we suggest that it be insured. 

Do not include accessories such as power cords or manuals. 

Please back up your internal program. Although every effort is made to save this 
data and reload it after repair, Remote Technologies Incorporated is neither liable 
for its loss, nor responsible for providing a back up for you. 

 

You must pay any shipping charges incurred in getting your TheaterTouch system 
controller to Remote Technologies Incorporated. Remote Technologies Incorporated 
will pay reasonable return shipping charges via a carrier of our choice to any 
destination within the United States if the repairs are covered under warranty. 

 

A copy of the original dated sales receipt must be provided whenever warranty 
service is required. You will need this receipt to establish the date of purchase. 
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Specifications 

Power: 4.8 VDC, 900 mAH NiMH Battery Pack 

Power Management: Automatic on/off (tilt switch) 

Infrared Control Range: 30 Feet (9.1m) @ 60 Degrees 

Infrared Frequency Range: 15kHz – 460kHz    
 (learning and transmission) 

Radio Frequency Control Range: Up to 100 Feet (30.5m)   
 (with optional IRF-6 System Interface) 

Radio Frequency Carrier: 418MHz (U.S. Model) 

Operating Temperature: +32°F to +122°F (+0°C to +50°C) 

Operating Humidity: 5% to 95% Non-condensing 

Touch Panel Display: High-resolution STN LCD Digital Matrix    
 128 x 64 pixels (Blue on Paper White) 
 Touchscreen never needs calibrating 

Display size (HW): 2.4 in. x 1.3 in. (61mm x 33mm)  

Backlights:          White EL (Display), Blue EL (Keypad) 

Nominal Run Time on Full Charge:                  6.5 hours minimum, continuous use 
                                                                      (10 to 15 days on average use) 

Standby Time on Full Charge:                              30 Days  

Battery Charge Time: 3-4 Hours                                                         

Total System Memory: 128K Bytes Flash (non-volatile) memory 

Device Capability: Total number of devices is limited only 
by memory 

Macro Capability:                                            Up to 64 steps in a single macro   
 -Total number of macros is limited 
   only by memory  

    -Macro capability on every button 
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Communications: PC compatible RS-232 port 

TheaterTouch Device ID: 10 unique ID codes available 

Optional IRF-6 System Interface ID: 10 unique ID codes available  

Dimensions-      Length: 9.9 in. (251mm) 

        Width: 2.4 in. (61mm) body, 2.9 in. (74mm) center 

                             Height:  1.1 in. (28mm)  

Enclosure: High impact molded ABS with textured 
finish                                                                             

  Weight: 11 oz. (312g) with battery pack              
8 oz. (227g) without battery pack   

 

All specifications subject to change without notice. 
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Appendix 

SOFTWARE LICENSE AGREEMENT 
This is a legal agreement between you (either an individual or an entity) and Remote 
Technologies Incorporated. By installing the software accompanying this guide you are 
agreeing to be bound by the terms of the agreement. If you do not agree to the terms of 
this agreement, promptly return the software CD-ROM and the accompanying items to 
the place you obtained them for a full refund.    

GRANT OF LICENSE.   This License Agreement permits you to use one copy of the 
Remote Technologies Incorporated software program (the “SOFTWARE”) on a single 
computer. The SOFTWARE is in “use” on a computer when it is loaded into temporary 
memory (i.e. RAM) or installed into permanent memory  (e.g. hard disk, diskette, CD-
ROM or other storage device) of that computer. However, installation on a network 
server for the sole purpose of internal distribution shall not constitute “use” for which a 
separate license is required, provided you have separate license for each computer to 
which the SOFTWARE is distributed.  

COPYRIGHT.     The SOFTWARE is owned by Remote Technologies Incorporated and 
is protected by United States copyright laws and international treaty provisions. 
Therefore, you must treat the SOFTWARE like any other copyrighted material (e.g. a 
book or musical recording) except that you may either (a) make one copy of the 
SOFTWARE solely for backup or archival purposes, or (b) transfer the SOFTWARE to a 
single hard disk provided you keep the original solely for backup or archival purposes. 
You may not copy the written materials accompanying the SOFTWARE. 

LIMITED WARRANTY.   Remote Technologies Incorporated guarantees that the disks 
on which the software is distributed are free from defects in materials and 
workmanship for a period of ninety (90) days from the date of purchase. Any written or 
oral information or advice given by Remote Technologies Incorporated distributors, 
dealers, agents or employees will in no way increase the scope of this warranty. If the 
software fails to meet the specifications of the warranty set forth above, Remote 
Technologies Incorporated liability and your exclusive remedy will be replacement of 
the CD-ROM or reasonable effort to make the product meet the above warranty 
specification.  

LIABILITY.   In no event shall Remote Technologies Incorporated or its suppliers be 
liable for any damages (including but not limited to damages for loss of profits, business 
interruption or loss of information) arising out of the use of or inability to use this 
software. Because some states do not allow for the exclusion or limitation of liability for 
consequential or incidental damages, the above limitation may not apply to you.  

OTHER RESTRICTIONS.    You may not rent or lease the SOFTWARE, but you may 
transfer the SOFTWARE accompanying written materials on a permanent basis 
provided you retain no copies and the recipient agrees to the terms of this Agreement. 
You may not reverse engineer, decompile or disassemble the SOFTWARE. If the 
SOFTWARE is an update or has been updated, any transfer must include the most 
recent update and all prior versions.   
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Index 

—A— 

adjust contrast. See control panel 

—B— 

batteries 
charging, 5 
installing, 6 
using, 5 

beeper. See control panel 
bitmaps 

placing, 22 
Bitmaps 

difference from Custom Buttons, 77 
Button Bitmap Editor 

creating a new bitmap, 85 
screen, 78 

Button Bitmas Editor. See Image Editors 
button properties 

disabled, 51 
editing, 51 
editing multiple, 57 
Infrared frequency, 55 
Infrared minimum repeats, 55 
Infrared sustain, 55 
IRF-6 IR outputs, 54 
IRF-6 Send this code, 54 
output type, 53 
pause, 52 
reversed, 51 
RF ID code, 53 
secured, 52 
special functions, 52 

buttons 
adding, 20 
changing styles, 33 
copying, 34 
cutting, 34 
defined, 20 
deleting, 20 
editing text, 21 
moving, 35 
pasting, 34 
resizing, 35 
selecting, 34 

—C— 

change passcode. See control panel 
Channel Macro Wizard. See macros 
charger. See batteries 

permanently mounting, 6 
cleaning the TheaterTouch, 4 
clear all. See control panel 
COM Port. See communications 
commands 

adding to buttons, 24 
removing from buttons, 26 

communications 
sending, 29 
setting up, 28 
troubleshooting. See troubleshooting 

computer link. See control panel 
contacting RTI 

general, 91 
service, 92 
technical support, 91 

contents, 2 
contrast. See control panel 
control panel, 8 

adjust contrast, 9 
beeper, 10 
change passcode, 12 
clear all, 14 
computer link, 13 
IR capture, 14 
program lockout, 11 
tilt switch, 11 
time out, 10 

Custom Button Editor. See Image Editors 
changing the active image, 84 
defining buttons, 82 
screen, 79 

custom buttons 
placing, 35 

Custom Buttons 
difference from Bitmaps, 77 

—E— 

e-mail 
sending the current file, 60 
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—F— 

features, 3 
file 

opening, 26 
previewing, 27 
saving, 26 

—I— 

Image Editors 
copying, 81 
creating new images, 80 
creating new libraries, 80 
cutting, 81 
drawing, 82 
drawing circles, 83 
drawing filled circles, 84 
drawing filled rectangles, 84 
drawing filled rounded rectangles, 84 
drawing lines, 83 
drawing rectangles, 83 
drawing rounded rectangles, 83 
editing libraries, 80 
erasing, 83 
filling areas, 83 
getting help, 81 
opening images, 80 
opening libraries, 80 
overview, 77 
painting, 82 
pasting, 81 
placing text, 83 
redoing changes, 81 
saving images, 80 
selecting, 82 
Tool Palette, 82 
toolbar, 80 
undoing changes, 81 
zooming, 82 

IR capture. See control panel 
IR Learning 

aligning the donor remote, 69 
capturing codes, 71 
hints, 63 
overview, 62 
testing captured codes, 73 
troubleshooting. See troubleshooting 
types of codes, 61 

IR Libraries 

adding a new remote, 67 
creating, 64 
editing commands, 74 
opening, 66 
opening the IR Library Manager, 64 
using the New Remote Wizard, 68 

IR Library Manager 
overview, 61 

—M— 

macros 
Button Test step, 38 
Channel Macro Wizard, 44 
defined, 36 
deleting, 40 
editing, 36 
editing commands in, 41 
Infrared from Library step, 37 
Infrared from Page step, 37 
Time Delay step, 37 
troubleshooting. See troubleshooting 

memory usage 
checking, 59 
defined, 59 

—P— 

page links. See pages, linking 
pages 

adding, 19 
defined, 19 
deleting, 19 
duplicating, 31 
linking, 23 
merging, 32 
PageWizard, 33 
removing links, 24 
renaming, 31 

printing 
screenshots, 58 
system configuration reports, 58 

program lockout. See control panel 

—R— 

remote properties, 47 
beeper, 48 
display mode, 47 
IRF-6 output labels, 50 
output type, 49 
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passcode, 48 
power down time, 47 
programming lockout, 48 
RF ID code, 49 
scroll rate, 48 
tilt switch, 47 

—S— 

Self-Downloading .EXE, 60 
specifications, 94 
System Configuration Report. See printing 

—T— 

technical support. See contacting RTI 
TheaterTouch Designer 

design hints, 17 
installing, 15 

overview, 15 
requirements, 2 
screen, 16 
updates, 15 

tilt switch. See control panel 
time out. See control panel 
touchscreen 

Main Menu, 8 
overview, 8 

troubleshooting, 87 
communications, 87 
display, 87 
IR codes, 89 
macros, 90 

—U— 

unpacking, 1 
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